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Preface

How to Use This Guide

Purpose of This
Guide

The Applied Biosystems 3130/3130xl Genetic Analyzers Getting Started Guide provides 
step-by-step instructions for preparing and analyzing a sample. It is designed to help you 
quickly learn how to use the Applied Biosystems 3130/3130xl Genetic Analyzers.

Audience This manual is written for principle investigators and laboratory staff who are planning 
to operate and maintain the Applied Biosystems 3130/3130xl Genetic Analyzers.

Assumptions This guide assumes you have the following background:

• Familiarity with Microsoft® Windows® XP operating system. 

• Knowledge of general techniques for handling DNA samples and preparing them 
for electrophoresis. 

• A general understanding of hard drives, data storage, file transfers, and copying and 
pasting.

If you want to integrate the 3130/3130xl Genetic Analyzers into your existing laboratory 
data flow system, you need networking experience.

Text Conventions This guide uses the following conventions: 

• Bold indicates user action. For example:

Type 0, then press Enter for each of the remaining fields.

• Italic text indicates new or important words and is also used for emphasis. For 
example:

Before analyzing, always prepare fresh matrix.

• A right arrow bracket (>) separates successive commands you select from a drop-
down or shortcut menu. For example:

Select File > Open > Spot Set.
Right-click the sample row, then select View Filter > View All Runs.

User Attention
Words

Two user attention words appear in Applied Biosystems user documentation. Each word 
implies a particular level of observation or action as described below:

• Note – Provides information that may be of interest or help but is not critical to the 
use of the product.

• IMPORTANT! – Provides information that is necessary for proper instrument 
operation, accurate chemistry kit use, or safe use of a chemical.
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Examples of the user attention words appear below:

Note: The size of the column affects the run time.

IMPORTANT! To verify your client connection to the database, you need a valid Oracle 
user ID and password.

Safety Alert
Words

Safety alert words also appear in user documentation. For more information, see “Safety 
Alert Words” on page xiv. 

How to Obtain More Information

Related
Documentation

The following related document is shipped with the system:

• Applied Biosystems 3130/3130xl Genetic Analyzers Maintenance, Troubleshooting, 
and Reference Guide (P/N 4352716) - Contains information on maintaining the 
instrument and computer system, troubleshooting tables to diagnose performance 
failures and advance reference content.

• Applied Biosystems 3130/3130xl Genetic Analyzers Site Preparation Guide 
(P/N 4352717) - Contains the space, environmental, and electrical requirements to 
support the 3130/3130xl Genetic Analyzer system.

• Applied Biosystems 3730/3730xl DNA Analyzers and Applied Biosystems 
3130/3130xl Genetic Analyzers AB Navigator Software Administrator Guide 
(P/N 4359472) - Contains information and procedures for the administrator 
maintaining the computer system and software files of the Applied Biosystems 
3130/3130xl Genetic Analyzers.

• Applied Biosystems 3130/3130xl Genetic Analyzers Quick Reference Card 
(P/N 4362825) - Contains a flowchart on how to run your samples and instrument, a 
table of maintenance tasks, and a Data Collection software reference guide.

Note: For additional documentation, see “How to Obtain Support” on page xi.

Send Us Your
Comments

Applied Biosystems welcomes your comments and suggestions for improving its user 
documents. You can e-mail your comments to:

techpubs@appliedbiosystems.com

mailto:techpubs@appliedbiosystems.com
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How to Obtain Support
For the latest services and support information for all locations, go to 
http://www.appliedbiosystems.com, then click the link for Support.

At the Support page, you can:

• Search through frequently asked questions (FAQs)

• Submit a question directly to Technical Support

• Order Applied Biosystems user documents, MSDSs, certificates of analysis, and 
other related documents

• Download PDF documents

• Obtain information about customer training

• Download software updates and patches

In addition, the Support page provides access to worldwide telephone and fax numbers 
to contact Applied Biosystems Technical Support and Sales facilities.

http://www.appliedbiosystems.com
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Safety

This safety section describes the following:

Safety Conventions Used in This Document . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  xiv

Symbols on Instruments  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xv

Safety Labels on Instruments  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .xvi

General Instrument Safety  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xvii

Chemical Safety  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .xviii

Chemical Waste Safety . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xx

Electrical Safety . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  xxi

Physical Hazard Safety . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .xxi

Laser Safety . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .xxi

Workstation Safety . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xxii

Safety and Electromagnetic Compatibility (EMC) Standards . . . . . . . . . . . . . . . . . .  xxiii
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Safety Conventions Used in This Document

Safety Alert
Words

Four safety alert words appear in Applied Biosystems user documentation at points in 
the document where you need to be aware of relevant hazards. Each alert 
word–IMPORTANT, CAUTION, WARNING, DANGER–implies a particular level of 
observation or action, as defined below:

Definitions

IMPORTANT! – Indicates information that is necessary for proper instrument operation, 
accurate chemistry kit use, or safe use of a chemical.

 – Indicates a potentially hazardous situation that, if not avoided, may 
result in minor or moderate injury. It may also be used to alert against unsafe practices.

 – Indicates a potentially hazardous situation that, if not avoided, 
could result in death or serious injury.

 – Indicates an imminently hazardous situation that, if not avoided, 
will result in death or serious injury. This signal word is to be limited to the most extreme 
situations.

Except for IMPORTANTs, each safety alert word in an Applied Biosystems document 
appears with an open triangle figure that contains a hazard symbol. These hazard 
symbols are identical to the hazard icons that are affixed to Applied Biosystems 
instruments (see “Safety Symbols” on page xvi).
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Examples

The following examples show the use of safety alert words:

IMPORTANT! You must create a separate a Sample Entry Spreadsheet for each 96-well 
microtiter plate.

The lamp is extremely hot. Do not touch the lamp until it has cooled 
to room temperature.

CHEMICAL HAZARD. Formamide. Exposure causes eye, skin, 
and respiratory tract irritation. It is a possible developmental and birth defect hazard. 
Read the MSDS, and follow the handling instructions. Wear appropriate protective 
eyewear, clothing, and gloves.

ELECTRICAL HAZARD. Failure to ground the instrument 
properly can lead to an electrical shock. Ground the instrument according to the provided 
instructions.

Symbols on Instruments

Electrical
Symbols on
Instruments

The following table describes the electrical symbols that may be displayed on 
Applied Biosystems instruments.

Symbol Description

Indicates the On position of the main power switch.

Indicates the Off position of the main power switch.

Indicates the On/Off position of a push-push main power switch.

Indicates a terminal that may be connected to the signal ground reference of 
another instrument. This is not a protected ground terminal.

Indicates a protective grounding terminal that must be connected to earth 
ground before any other electrical connections are made to the instrument.

Indicates a terminal that can receive or supply alternating current or voltage.

Indicates a terminal that can receive or supply alternating or direct current or 
voltage.
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Safety Symbols The following table describes the safety symbols that may be displayed on 
Applied Biosystems instruments. Each symbol may appear by itself or in combination 
with text that explains the relevant hazard (see “Safety Labels on Instruments” on 
page xvi). These safety symbols may also appear next to DANGERS, WARNINGS, and 
CAUTIONS that occur in the text of this and other product-support documents.

Safety Labels on Instruments
The following CAUTION, WARNING, and DANGER statements may be displayed on 
Applied Biosystems instruments in combination with the safety symbols described in the 
preceding section. 

Symbol Description

Indicates that you should consult the manual for further information and to 
proceed with appropriate caution.

Indicates the presence of an electrical shock hazard and to proceed with 
appropriate caution.

Indicates the presence of a hot surface or other high-temperature hazard and to 
proceed with appropriate caution. 

Indicates the presence of a laser inside the instrument and to proceed with 
appropriate caution.

Indicates the presence of moving parts and to proceed with appropriate caution.

English Francais

CAUTION Hazardous chemicals. Read the 
Material Safety Data Sheets (MSDSs) before 
handling.

ATTENTION Produits chimiques dangeureux. 
Lire les fiches techniques de sûreté de 
matériels avant la manipulation des produits.

CAUTION Hazardous waste. Read the waste 
profile (if any) in the site preparation guide for 
this instrument before handling or disposal.

ATTENTION Déchets dangereux. Lire les 
renseignements sur les déchets avant de les 
manipuler ou de les éliminer.

CAUTION Hazardous waste. Refer to 
MSDS(s) and local regulations for handling 
and disposal.

ATTENTION Déchets dangereux. Lire les 
fiches techniques de sûreté de matériels et la 
régulation locale associées à la manipulation 
et l'élimination des déchets.

WARNING Hot lamp. AVERTISSEMENT Lampe brûlante.

WARNING Hot. Replace lamp with an 
Applied Biosystems lamp.

AVERTISSEMENT Composants brûlants. 
Remplacer la lampe par une lampe 
Applied Biosystems.

CAUTION Hot surface. ATTENTION Surface brûlante.

DANGER High voltage. DANGER Haute tension.
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General Instrument Safety

PHYSICAL INJURY HAZARD. Use this product only as 
specified in this document. Using this instrument in a manner not specified by 
Applied Biosystems may result in personal injury or damage to the instrument.

Moving and
Lifting the

Instrument

PHYSICAL INJURY HAZARD. The instrument is to be moved 
and positioned only by the personnel or vendor specified in the applicable site 
preparation guide. If you decide to lift or move the instrument after it has been installed, 
do not attempt to lift or move the instrument without the assistance of others, the use of 
appropriate moving equipment, and proper lifting techniques. Improper lifting can cause 
painful and permanent back injury. Depending on the weight, moving or lifting an 
instrument may require two or more persons.

WARNING To reduce the chance of electrical 
shock, do not remove covers that require tool 
access. No user-serviceable parts are inside. 
Refer servicing to Applied Biosystems 
qualified service personnel.

AVERTISSEMENT Pour éviter les risques 
d'électrocution, ne pas retirer les capots dont 
l'ouverture nécessite l'utilisation d'outils. 
L’instrument ne contient aucune pièce 
réparable par l ’utilisateur. Toute intervention 
doit être effectuée par le personnel de service 
qualifié de Applied Biosystems.

DANGER Class 3B laser radiation present 
when open and interlock defeated. Avoid 
direct exposure to laser beam.

DANGER Class 3B rayonnement laser en cas 
d’ouverture et d’une neutralisation des 
dispositifs de sécurité. Eviter toute exposition 
directe avec le faisceau.

DANGER Class 3B laser radiation when 
open. Avoid direct exposure to laser beam.

DANGER Class 3B rayonnement laser en cas 
d’ouverture. Eviter toute exposition directe 
avec le faisceau.

DANGER Class 2(II) laser radiation present 
when open and interlock defeated. Do not 
stare directly into the beam

DANGER de Class 2(II) rayonnement laser en 
cas d'ouverture et d'une neutralisation des 
dispositifs de securite. Eviter toute exposition 
directe avec le faisceau.

DANGER Class 2(II) laser radiation present 
when open. Do not stare directly into the 
beam. 

DANGER de Class 2(II) rayonnement laser en 
cas d'ouverture. Eviter toute exposition 
directe avec le faisceau.

DANGER Class 2(II) LED when open and 
interlock defeated. Do not stare directly into 
the beam.

DANGER de Class 2(II) LED en cas 
d'ouverture et d'une neutralisation des 
dispositifs de securite. Eviter toute exposition 
directe avec le faisceau.

DANGER Class 2(II) LED when open. Do not 
stare directly into the beam.

DANGER de Class 2(II) LED en cas 
d'ouverture. Eviter toute exposition directe 
avec le faisceau.

CAUTION Moving parts. ATTENTION Parties mobiles.

English Francais
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Moving and
Lifting Stand-

Alone Computers
and Monitors

Do not attempt to lift or move the computer or the monitor without 
the assistance of others. Depending on the weight of the computer and/or the monitor, 
moving them may require two or more people.

Things to consider before lifting the computer and/or the monitor:

• Make sure that you have a secure, comfortable grip on the computer or the monitor 
when lifting.

• Make sure that the path from where the object is to where it is being moved is clear 
of obstructions.

• Do not lift an object and twist your torso at the same time.

• Keep your spine in a good neutral position while lifting with your legs.

• Participants should coordinate lift and move intentions with each other before 
lifting and carrying.

• Instead of lifting the object from the packing box, carefully tilt the box on its side 
and hold it stationary while someone slides the contents out of the box.

Operating the
Instrument

Ensure that anyone who operates the instrument has:

• Received instructions in both general safety practices for laboratories and specific 
safety practices for the instrument.

• Read and understood all applicable Material Safety Data Sheets (MSDSs). See 
“About MSDSs” on page xviii.

Chemical Safety

Chemical Hazard
Warning

CHEMICAL HAZARD. Before handling any chemicals, refer to 
the Material Safety Data Sheet (MSDS) provided by the manufacturer, and observe all 
relevant precautions.

CHEMICAL HAZARD. All chemicals in the instrument, including 
liquid in the lines, are potentially hazardous. Always determine what chemicals have 
been used in the instrument before changing reagents or instrument components. Wear 
appropriate eyewear, protective clothing, and gloves when working on the instrument.

About MSDSs Chemical manufacturers supply current Material Safety Data Sheets (MSDSs) with 
shipments of hazardous chemicals to new customers. They also provide MSDSs with the 
first shipment of a hazardous chemical to a customer after an MSDS has been updated. 
MSDSs provide the safety information you need to store, handle, transport, and dispose 
of the chemicals safely.

Each time you receive a new MSDS packaged with a hazardous chemical, be sure to 
replace the appropriate MSDS in your files.
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Obtaining MSDSs You can obtain from Applied Biosystems the MSDS for any chemical supplied by 
Applied Biosystems. This service is free and available 24 hours a day. 

To obtain MSDSs:

1. Go to https://docs.appliedbiosystems.com/msdssearch.html

2. In the Search field, type in the chemical name, part number, or other information 
that appears in the MSDS of interest. Select the language of your choice, then click 
Search.

3. Find the document of interest, right-click the document title, then select any of the 
following:

• Open – To view the document

• Print Target – To print the document

• Save Target As – To download a PDF version of the document to a destination 
that you choose

4. To have a copy of a document sent by fax or e-mail, select Fax or Email to the left 
of the document title in the Search Results page, then click RETRIEVE 
DOCUMENTS at the end of the document list.

5. After you enter the required information, click View/Deliver Selected Documents 
Now.

Chemical Safety
Guidelines

To minimize the hazards of chemicals:

• Read and understand the Material Safety Data Sheets (MSDS) provided by the 
chemical manufacturer before you store, handle, or work with any chemicals or 
hazardous materials. (See “About MSDSs” on page xviii.)

• Minimize contact with chemicals. Wear appropriate personal protective equipment 
when handling chemicals (for example, safety glasses, gloves, or protective 
clothing). For additional safety guidelines, consult the MSDS.

• Minimize the inhalation of chemicals. Do not leave chemical containers open. Use 
only with adequate ventilation (for example, fume hood). For additional safety 
guidelines, consult the MSDS. 

• Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the 
manufacturer’s cleanup procedures as recommended on the MSDS.

• Comply with all local, state/provincial, or national laws and regulations related to 
chemical storage, handling, and disposal.

https://docs.appliedbiosystems.com/msdssearch.html
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Chemical Waste Safety

Chemical Waste
Hazard

HAZARDOUS WASTE. Refer to Material Safety Data Sheets and 
local regulations for handling and disposal.

CHEMICAL WASTE HAZARD. Wastes produced by Applied 
Biosystems instruments are potentially hazardous and can cause injury, illness, or death.

Chemical Waste
Safety Guidelines

To minimize the hazards of chemical waste:

• Read and understand the Material Safety Data Sheets (MSDSs) provided by the 
manufacturers of the chemicals in the waste container before you store, handle, or 
dispose of chemical waste.

• Provide primary and secondary waste containers. (A primary waste container holds 
the immediate waste. A secondary container contains spills or leaks from the 
primary container. Both containers must be compatible with the waste material and 
meet federal, state, and local requirements for container storage.) 

• Minimize contact with chemicals. Wear appropriate personal protective equipment 
when handling chemicals (for example, safety glasses, gloves, or protective 
clothing). For additional safety guidelines, consult the MSDS.

• Minimize the inhalation of chemicals. Do not leave chemical containers open. Use 
only with adequate ventilation (for example, fume hood). For additional safety 
guidelines, consult the MSDS.

• Handle chemical wastes in a fume hood.

• After emptying the waste container, seal it with the cap provided.

• Dispose of the contents of the waste tray and waste bottle in accordance with good 
laboratory practices and local, state/provincial, or national environmental and health 
regulations.

Waste Disposal If potentially hazardous waste is generated when you operate the instrument, you must:

• Characterize (by analysis if necessary) the waste generated by the particular 
applications, reagents, and substrates used in your laboratory.

• Ensure the health and safety of all personnel in your laboratory.

• Ensure that the instrument waste is stored, transferred, transported, and disposed of 
according to all local, state/provincial, and/or national regulations.

IMPORTANT! Radioactive or biohazardous materials may require special handling, and 
disposal limitations may apply.
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Electrical Safety

ELECTRICAL SHOCK HAZARD. Severe electrical shock can 
result from operating the Applied Biosystems 3130/3130xl Genetic Analyzers without 
its instrument panels in place. Do not remove instrument panels. High-voltage contacts 
are exposed when instrument panels are removed from the instrument.

Power ELECTRICAL HAZARD. Grounding circuit continuity is vital for 
the safe operation of equipment. Never operate equipment with the grounding conductor 
disconnected.

ELECTRICAL HAZARD. Use properly configured and approved 
line cords for the voltage supply in your facility.

ELECTRICAL HAZARD. Plug the system into a properly 
grounded receptacle with adequate current capacity.

Overvoltage
Rating

The Applied Biosystems 3130/3130xl Genetic Analyzers have an installation 
(overvoltage) category of II, and is classified as portable equipment.

Physical Hazard Safety

Moving Parts PHYSICAL INJURY HAZARD. Moving parts can crush and cut. 
Keep hands clear of moving parts while operating the instrument. Disconnect power 
before servicing the instrument.

Laser Safety

Laser
Classification

The Applied Biosystems 3130/3130xl Genetic Analyzers use an Argon laser. Under 
normal operating conditions, the instrument laser is categorized as a Class I laser. When 
safety interlocks are disabled during certain servicing procedures, the laser can cause 
permanent eye damage, and, therefore, is classified under those conditions as a Class 3B 
laser.

The Applied Biosystems 3130/3130xl Genetic Analyzers has been tested to and 
complies with 21 CFR, 1040.10 and 1040.11, as applicable.”

The Applied Biosystems 3130/3130xl Genetic Analyzers have been tested to and 
complies with standard EN60825-1, “Radiation Safety of Laser Products, Equipment 
Classification, Requirements, and User’s Guide.”
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Laser Safety
Requirements

To ensure safe laser operation:

• The system must be installed and maintained by an Applied Biosystems Technical 
Representative.

• All instrument panels must be in place on the instrument while the instrument is 
operating. When all panels are installed, there is no detectable radiation present. If 
any panel is removed when the laser is operating (during service with safety 
interlocks disabled), you may be exposed to laser emissions in excess of the Class 
3B rating.

• Do not remove safety labels or disable safety interlocks.

Additional Laser
Safety

Information

Refer to the user documentation provided with the laser for additional information on 
government and industry safety regulations.

LASER HAZARD. Lasers can burn the retina causing permanent 
blind spots. Never look directly into the laser beam. Remove jewelry and other items that 
can reflect the beam into your eyes. Do not remove the instrument top or front panels. 
Wear proper eye protection and post a laser warning sign at the entrance to the laboratory 
if the top or front panels are removed for service.

LASER BURN HAZARD. An overheated laser can cause severe 
burns if it comes in contact with the skin. DO NOT operate the laser when it cannot be 
cooled by its cooling fan. Always wear appropriate laser safety goggles.

Workstation Safety
Correct ergonomic configuration of your workstation can reduce or prevent effects such 
as fatigue, pain, and strain. Minimize or eliminate these effects by configuring your 
workstation to promote neutral or relaxed working positions.

MUSCULOSKELETAL AND REPETITIVE MOTION 
HAZARD. These hazards are caused by potential risk factors that include but are not 
limited to repetitive motion, awkward posture, forceful exertion, holding static unhealthy 
positions, contact pressure, and other workstation environmental factors.

To minimize musculoskeletal and repetitive motion risks:

• Use equipment that comfortably supports you in neutral working positions and 
allows adequate accessibility to the keyboard, monitor, and mouse.

• Position the keyboard, mouse, and monitor to promote relaxed body and head 
postures.
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Safety and Electromagnetic Compatibility (EMC) Standards
This section provides information on:

• U.S. and Canadian Safety Standards

• Canadian EMC Standard

• European Safety and EMC Standards

• Australian EMC Standards

U.S. and
Canadian Safety

Standards

This instrument has been tested to and complies with standard UL 3101-1, “Safety 
Requirements for Electrical Equipment for Laboratory Use, Part 1: General 
Requirements.”

This instrument has been tested to and complies with standard CSA 1010.1, “Safety 
Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use, 
Part 1: General Requirements.”

Canadian EMC
Standard

This instrument has been tested to and complies with ICES-001, Issue 3: Industrial, 
Scientific, and Medical Radio Frequency Generators.

European Safety
and EMC

Standards

Safety

This instrument meets European requirements for safety (Low Voltage Directive 
73/23/EEC). This instrument has been tested to and complies with standards EN 61010-
1:2001, “Safety Requirements for Electrical Equipment for Measurement, Control and 
Laboratory Use, Part 1: General Requirements” and EN 61010-2-010, “Particular 
Requirements for Laboratory Equipment for the Heating of Materials.”

EMC

This instrument meets European requirements for emission and immunity (EMC 
Directive 89/336/EEC). This instrument has been tested to and complies with standard 
EN 61326 (Class B), “Electrical Equipment for Measurement, Control and Laboratory 
Use – EMC Requirements.”

Australian EMC
Standards

This instrument has been tested to and complies with standard AS/NZS 2064, “Limits 
and Methods Measurement of Electromagnetic Disturbance Characteristics of Industrial, 
Scientific, and Medical (ISM) Radio-frequency Equipment.”
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Notes

1

Chapter 1

Preparing the Instrument

Preparing the
Instrument

Start the
system

Start Data Collection
software

Check polymer block,
select capillary array,

and polymer

Prepare buffer and
fill reservoirs

Performing a
Spatial Calibration

Performing a
Spectral Calibration

Autoanalysis
and Sequencing
Analysis
Software

Autoanalysis
and
Fragment Analysis

Autoanalysis
and
SeqScape Software

Running the
Instrument

See page 12

See page 16

See page 2

See page 2

See page 7

See page 9
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Notes

Instrument Description

Instrument Layout A typical laboratory layout is shown below.
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Notes

1
Application Summary Tables

Sequencing
Resolution

Performance and
Specifications

Decide what combination of capillary array and polymer from the table below matches 
your resolution and performance specifications.

 Type of Run
Capillary 
Length

(cm)

Polymer

Type
Module

Run 
Time 
(min)

24 hr Throughput 
(number of 
samples) KB 

Basecaller 
QV20 LORa b3130

Genetic 
Analyzer

3130xl

Genetic 
Analyzer

Ultra rapid 36 POP-4™ UltraSeq36_POP4 40 144 576 400 

POP-7™ UltraSeq36_POP7 35 164 656 500

Rapid 36 POP-6™ RapidSeq36_POP6 60 96 384 500 

POP-7 RapidSeq36_POP7 96 384 600

Fast 50 POP-7 FastSeq50_POP7 60 96 384 700

Standard 50 POP-4 StdSeq50_POP4 100 56 224 600 

POP-6 StdSeq50_POP6 150 36 144 600 

POP-7 StdSeq50_POP7 120 48 192 850

Long read 80 POP-4 LongSeq80_POP4 210 24 96 700

POP-7 LongSeq80_POP7 170 32 128 950

a Length of Read (LOR) is the usable range of high-quality or high-accuracy bases determined by Quality Values (QV) generated 
by KB™ Basecaller v1.2. The LOR is determined by using a sliding window of 20 bases, which has an average QV > 20.

b 98.5% basecalling accuracy, less than 2% Ns.
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4 Applied Biosystems 3130/3130xl Genetic Analyzers Getting Started Guide

Notes

Fragment
Analysis

Resolution
Performance and

Specifications

Decide what combination of capillary array and polymer from the table below matches 
your resolution and performance specifications. See “Fragment Analysis Kits and Run 
Modules” on page 5 for information on capillary, polymer, and run module.

Run Modules
Capillary
Length

(cm)

Polymer

Type

Run 
Time 
(min)

24 hr Throughput (GTa)
Resolution

(bp)
Specification 

(SD)b3130 
Analyzer

3130xl 
Analyzer

High Throughput, Small Size Fragment Analysis

FragmentAnalysis22
_POP4

22 POP-4 20 5,760 23,040 250 0.15

SNP22_POP4 22 20 5,760 23,040 120 0.50

Standard Fragment Analysis

FragmentAnalysis36
_POP4

36 POP-4 45 2,560 10,240 500 0.15

HIDFragmentAnalysis
36_POP4

45 2,560 10,240 500 0.15

SNP36_POP4 30 3,840 15,360 120 0.50

FragmentAnalysis36
_POP7

POP-7 35 3,290 13,170 500 0.15

FragmentAnalysis50
_POP4

50 POP-4 65 1,760 7,040 500 0.15

FragmentAnalysis50
_POP6

POP-6 90 1,200 4,800 500 0.15

FragmentAnalysis50
_POP7

POP-7 50 2,300 9,220 500 0.15

a 20 GT (Genotypes)/capillary/injection.
b 1bp resolution at 99.99% accuracy. 
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Application Summary Tables
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Notes

1

Fragment
Analysis Kits and

Run Modules

The table below lists the Applied Biosystem kit types, with the available run module(s) 
and dye sets.

AmpFlSTR Kit Table

Module

S
N

P
22

_P
O

P
4

S
N

P
36

_P
O

P
4

H
TS

N
P

36
_P

O
P

7
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en

tA
na
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si

s2
2_

P
O

P
4
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si
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6_

P
O

P
4
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si

s3
6_

P
O

P
7

Fr
ag
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en
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na
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si

s5
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P
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P
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6

Fr
ag

m
en

tA
na

ly
si

s5
0_

P
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P
7

H
ID
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en
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si

s3
6_

P
O

P
4

Application/Kit

SNaPshot® Multiplex System E5 E5

Custom oligos D, F, 
G5

D, F, 
G5

D, F, 
G5

D, F, 
G5

D, F, 
G5

D, F, 
G5

Linkage Mapping Set (human) 
v2.5

D, G5 D, G5 D, G5 D, G5 D, G5 D, G5

ABI PRISM® Mouse Mapping Set 
v1.0

D, G5 D, G5 D, G5 D, G5 D, G5 D, G5

4-Dye Stockmarks® kits (bovine 
and canine) 

F

5-Dye Stockmarks® kit (equine) G5

AFLP® kits F

4-Dye AmpFlSTR® kits F

5-Dye AmpFlSTR kits G5

Kits
HIDFragmentAnalysis
36_POP4

AmpFlSTR COfiler® Kit

AmpFlSTR Profiler Plus® Kit

AmpFlSTR Profiler Plus ID Kit

AmpFlSTR SGM Plus® Kit

Other 4-Dye AmpFlSTR Kits

F

AmpFlSTR SEfiler™ Kit

AmpFlSTR Identifiler® Kit

AmpFlSTR Yfiler™ Kit

Other 5-Dye AmpFlSTR Kits

G5
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6 Applied Biosystems 3130/3130xl Genetic Analyzers Getting Started Guide

Notes

Barcode Readers

                                 ELECTRICAL HAZARD. Power off the instrument and the 
computer before connecting an external barcode reader to the instrument.

External Barcode
Readers

KEYENCE BL-80VE

An external barcode reader can be used with the 3130/3130xl instrument. With the 
KEYENCE BL-80VE (see photo above), which connects to the instrument computer 
keyboard, you can scan barcodes into any text box in the Data Collection software. The 
KEYENCE BL-80VE barcode reader uses an LED as a light source.
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Starting the 3130/3130xl Genetic Analyzer System
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Notes

1
Starting the 3130/3130xl Genetic Analyzer System

Starting the Computer Workstation

IMPORTANT! You must start the computer 
workstation before starting the instrument.

1. Power on the monitor.

2. Power on the computer. 

3. In the Log On to Windows dialog box:

a. Enter the user name. 

b. If applicable, enter a password.

Note: If the computer is connected to a 
network, you do not need to log on to the 
network before starting the instrument.

c. Click .
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Notes

Starting the 3130/3130xl Genetic Analyzer

1. Ensure that the:

• Oven door is closed and locked

• Instrument doors are closed

Note: If the doors are open during power on, the 
yellow light will continue to flash until you close 
the doors.

2. Ensure that the computer is powered on.

Note: The computer must be on and running to 
allow the instrument to copy the firmware from 
the computer.

3. Power on the instrument by pressing the on/off 
button on the front of the instrument.

Note: While the instrument is booting up and 
performing self-checks, the yellow status light 
blinks. 

4. Ensure the green status light is on and not 
flashing before proceeding. 

Note: If the green status light does not come on, 
start the Data Collection software and view the 
log. The pathway to the log is: 
E:\AppliedBiosystems\UDC\DataCollection\
Log\Instrument Name

Press the on/off button to start the instrument

Status lights 
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Notes

1
Data Collection Software

IMPORTANT! Do not rename the computer. The 
instrument computer was assigned a unique name 
before the 3130/3130xl genetic analyzer Data 
Collection software was installed. Do not rename the 
computer once the Data Collection software has been 
installed. Doing so may cause the Data Collection 
software to malfunction. 

Starting the 3130/3130xl Data Collection 
Software

1. Select Start > All Programs > Applied 
Biosystems > Data Collection > Run 3130 
Data Collection v3.0 or Run 3130xl Data 
Collection v3.0 to display the Service Console. 
By default, all applications are off, indicated by 
the red circles. They launch automatically with 
the 3130/3130xl Data Collection software.

As each application activates, the red circles (off) 
change to yellow triangles (activating), and then 
to green squares (on) when they are fully 
functional.

When all the applications are running (displaying 
all green squares–this could take several 
minutes), the Foundation Data Collection 
window displays. 

On 

Activating
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Notes

2. Click + to expand subfolders in the left tree pane. 
All application folders are now visible. 

Select items from this tree pane to open manager, 
viewer, and other program windows.

3. Click + to expand subfolders in the left tree pane. 
All application folders are now visible. 

Select items from this tree pane to open manager, 
viewer, and other program windows.
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Notes

1
Preparing the Instrument

Instrument Doors
and Interior

Part Function

Anode buffer reservoir Contains 16 mL of 1X running buffer.

Buffer and water 
reservoirs (four)

Each contain 16 mL of 1X running buffer or water.

Autosampler Holds the sample plates and reservoirs and moves to align 
the samples, water, or buffer with the capillaries.

Capillary array Enables the separation of the fluorescent-labeled DNA 
fragments by electrophoresis. It is a replaceable unit 
composed of 4 or 16 silica capillaries.

Detection cell block and 
heater

Holds the capillaries in place for laser detection.

Lower polymer block Contains the buffer valve, anode electrode, and anode 
buffer reservoir.

Oven Maintains uniform capillary array temperature.

Polymer delivery pump 
(PDP)

Pumps polymer into the array and performs maintenance 
procedures.

Pump block Includes the displacement pump chamber, piston water 
seal, array attachment point (array port), and connection to 
the lower polymer block through the interconnect tube. 

G
R

24
60

Detection cell block

Capillary array

Autosampler

Polymer delivery pump (PDP)

Anode buffer reservoir

Lower polymer block

Buffer and water
reservoirs

Oven

Pump block
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Notes

Inspecting the Instrument

1. Open the instrument doors.

2. Perform the daily maintenance tasks -see 
Chapter 1 in the Applied Biosystems 3130/3130xl 
Genetic Analyzers Maintenance, 
Troubleshooting and Reference Guide.

3. Install clean drip trays.

Polymer Delivery Pump

GR2459

PDP motor cover

PDP motor

Double-tapered ferrule

Array port

Capillary array tip

Piston

Pump block

Check valve

Polymer supply
bottle cap with

hole

Mounting pin

Polymer supply tube

Syringe fitting

Polymer 
supply bottle

Lower polymer block

Buffer fill-line

Anode buffer reservoir 
(16 mL anode reservoir)

Electrode

Overflow hole

Water seal

Capillary array

Buffer valve pin

O-ring

Mounting pin
Mounting

pin

Interconnect tube

Mounting pin

Capillary array knob

 Pump chamber

Waste fitting
Water trap
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Preparing the Instrument
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Notes

1

Inspecting the Instrument

1. Open the instrument doors.

2. Perform the daily maintenance tasks -see the 
Applied Biosystems 3130/3130xl Genetic 
Analyzers Maintenance, Troubleshooting and 
Reference Guide for more detail on maintenance.

3. Install clean drip trays.

Installing or Replacing the Capillary Array

IMPORTANT! The capillary array length defined in 
the wizard must match the array length you are using 
for correct autoanalysis results. 

IMPORTANT! Wear gloves while 
handling polymer, the capillary array, 
septa, or buffer reservoirs. 

CHEMICAL HAZARD. POP 
polymer may cause eye, skin, and respiratory tract 
irritation. Please read the MSDS, and follow the 
handling instructions. Wear appropriate protective 
eyewear, clothing, and gloves. Use for research and 
development purposes only.

1. Install a capillary array by clicking <instrument 
name>, selecting Install Array Wizard and 
following the prompts.

IMPORTANT! To install or replace an array that 
is a different length than the one you were using, 
reset the active spectral calibration (see page 47) 
or create a new spectral calibration for your dye 
set and array length combination (see page 37).

2. Optional: Select Update Cap Array Info wizard 
to correct any errors or update capillary array and 
serial number information.
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Notes

When to Replenish or Change Polymer

IMPORTANT! Always replace 
polymer that has been on the 
instrument longer than one week.

Before Using the Polymer

1. Remove the polymer from 4 °C storage.

2. Loosen the cap and bring the polymer to room 
temperature. 

3. To dissolve deposits, tighten the cap and gently 
swirl the polymer.

Replenishing the Polymer

IMPORTANT! Wear gloves while 
handling polymer, the capillary array, 
septa, or buffer reservoirs. 

CHEMICAL HAZARD. POP 
polymer may cause eye, skin, and respiratory tract 
irritation. Please read the MSDS, and follow the 
handling instructions. Wear appropriate protective 
eyewear, clothing, and gloves. Use for research and 
development purposes only.

1. Click < Instrument Name> in the tree pane. 

Su M T W Th F S

If polymer on the instrument... Then ...

has been on less than one week and is in sufficient quantity 
to complete your runsa

Remove all bubbles, and then proceed with instrument 
preparation.

has been on less than one week, and insufficient in quantity 
to complete your runs

Add fresh polymer to the polymer supply by following the 
Replenish Polymer Wizard.

has been on longer than one week

is the wrong type (a change between POP-4, POP-6, and/or 
POP-7 polymers is required)

Replace the installed polymer type with a different type by 
following the Change Polymer Type Wizard.

a A 3130xl genetic analyzer run uses 50 to 80 µL of polymer and a 3130 genetic analyzer run uses ~25 to 40µL of polymer. 
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Notes

1

2. Select Wizards > Replenish Polymer Wizard 
to replenish polymer. 

IMPORTANT! The polymer type defined in the 
wizard must match the polymer type that you are 
using. 

Changing Polymer Type

IMPORTANT! Wear gloves while 
handling polymer, the capillary array, 
septa, or buffer reservoirs. 

CHEMICAL HAZARD. POP 
polymer may cause eye, skin, and respiratory tract 
irritation. Please read the MSDS, and follow the 
handling instructions. Wear appropriate protective 
eyewear, clothing, and gloves. Use for research and 
development purposes only.

1. Click < Instrument Name> in the tree pane.

2. Select Wizards > Change Polymer Type 
Wizard to change to a different polymer. 
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Notes

Preparing Buffer and Filling Reservoirs

Required Materials

CHEMICAL HAZARD. 10X 
Genetic Analyzer Buffer with EDTA may cause 
eye, skin, and respiratory tract irritation. Read the 
MSDS, and follow the handling instructions. Wear 
appropriate protective eyewear, clothing, and gloves.

Required materials to prepare 1X running buffer:

• 10X Genetic Analyzer Buffer (P/N 402824)

• Purified (distilled or deionized) water

• 50 mL graduated cylinder

Preparing Buffer for a Single Run

1. Add 5 mL of 10X Genetic Analyzer buffer into a 
graduated cylinder.

2. Add purified water to bring the total volume up 
to 50 mL.

3. Mix well.

Storing Buffer

Store 1X running buffer at: 

• 2 to 8 °C for up to 1 month

• Room temperature for 1 week

50 mL 
total

45 mL DI H2O

5 mL 10X Genetic 
Analyzer buffer

50 mL graduated cylinder

Buffer Storage Conditions

Option A Option B

Su M T W Th F S

2 °C to 
8 °C

1 month

20 °C to 
25 °C

7 days

Su M T W Th F S
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Notes

1

Replacing Buffer and Water

Replace the 1X running buffer in the anode and 
cathode buffer reservoirs daily, or before each batch 
of runs.

IMPORTANT! Failing to replace buffer may lead to 
loss of resolution and data quality.

IMPORTANT! To clean and refill the reservoirs, the 
autosampler is brought to the forward position, 
thereby leaving the capillary tips exposed to the air. 
Do not leave the autosampler in this position for an 
extended time because the capillaries can dry out and 
the array may be damaged.

Filling the Water and Cathode Buffer 
Reservoirs

IMPORTANT! Wear gloves while 
performing the following procedure, 
and any other time you handle the 
capillary array, septa, or buffer 
reservoirs.

CHEMICAL HAZARD. 1✕ 
Genetic Analyzer Buffer with EDTA may cause eye, 
skin, and respiratory tract irritation. Read the MSDS, 
and follow the handling instructions. Wear 
appropriate protective eyewear, clothing, and gloves.

1. Verify the oven and instrument doors are closed.

2. Press the Tray button on the outside of the 
instrument to bring the autosampler to the 
forward position

3. Wait until the autosampler stops at the forward 
position, then open the instrument door. 

Tray button 
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Notes

4. Remove the cathode buffer and water reservoirs 
from the instrument.

5. Dispose of remaining fluids and rinse out the 
reservoirs with deionized water.

Note: Follow your company’s waste disposal 
practices for appropriate disposal procedures. 

6. Rinse the cathode reservoir with 1X running 
buffer, and then fill to the line with 1X running 
buffer (about 16 mL).

7. Fill the two water reservoirs to the line with 
quality deionized water (about 16 mL). 

Be sure that the septa fit 
securely and flush on the tops of the reservoirs to 
prevent damaging the capillary tips.

8. Place a clean reservoir septa on each reservoir, 
and dry the outside of the reservoirs using a 
lint-free tissue wipe.

9. Place the reservoirs into position on the 
autosampler as shown.

10. Close the instrument doors.

Note: Closing the doors returns the autosampler 
to the last known position, placing the tips of the 
capillaries in water or buffer.

Remove

G
R

18
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b

Fill line

Water reservoir
(waste)

Cathode reservoir
(1X running buffer)

Water reservoir
(rinse)

Water reservoir 
(unused)

Home position
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Notes

1

Filling the Anode Buffer Reservoir

Change the anode buffer:

• Every 24 hours

• Before each run or batch of runs

• Every time you replenish the polymer or change 
polymer type

CHEMICAL HAZARD. 1X 
Genetic Analyzer Buffer with EDTA may cause eye, 
skin, and respiratory tract irritation. Read the MSDS, 
and follow the handling instructions. Wear 
appropriate protective eyewear, clothing, and gloves.

1. Remove the anode buffer reservoir by firmly 
pulling down and twisting slowly. 

2. Discard the used buffer appropriately.

3. Clean and rinse the reservoir with deionized 
water, and then rinse with buffer.

4. Fill the anode buffer reservoir to the fill line with 
fresh 1X running buffer (about 16 mL). 

Note: The meniscus should line up with the 
fill line.

5. Put the anode buffer reservoir on the instrument.

6. If the reservoir fills with fluid, repeat this 
procedure to discard and replace the running 
buffer. 

Note: The reservoir could fill during bubble 
removal.

Change the Anode Buffer

Every 24 hours Before each run 
or batch of runs

G
R

24
61

Fill line
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Notes
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Notes

Chapter 2

2

Performing a Spatial Calibration

Performing a
Spatial Calibration

Start a spatial
calibration run

Evaluate spatial
calibration profile

Accept or reject
spatial calibration

Performing a
Spectral Calibration

Autoanalysis
and Sequencing
Analysis
Software

Autoanalysis
and
Fragment Analysis

Autoanalysis
and
SeqScape Software

Running the
Instrument

Preparing the
Instrument

See page 22

See page 23

See page 24
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Notes

Spatial Calibration

The 3130/3130xl genetic analyzer Data Collection software uses images collected during 
the spatial calibration to establish a relationship between the signal emitted by each 
capillary and the position where that signal falls on and is detected by the CCD camera.

When to Perform
the Calibration

You are required to perform a spatial calibration when you:

• Install or replace a capillary array

• Temporarily remove the capillary array from the detection block

• Move the instrument

Creating a Spatial Calibration File

1. In the tree pane of the Data Collection software, click 
GA Instruments > ga3130 or ga3130xl > instrument 

name > Spatial Run Scheduler.

Spatial 
profile

Start, Accept 
or Reject 
Spatial profile 

Positions (pixel) 
of each capillary
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Notes

2

2. In the Spatial Protocols section, select one of the 
following:

• If the capillaries contain fresh polymer, 
select Protocol > 3130SpatialNoFill_1

• Otherwise, select Protocol 
> 3130SpatialFill_1 

Note: You do not need to fill the capillaries each 
time you perform a spatial calibration. 

3. Click . 

The calibration run lasts approximately:

• 2 min. without filling the capillaries

• 6 min. when filling the capillaries

Note: The spatial profile window turns black 
when you start a spatial calibration. 

Evaluating a Spatial Calibration File
1. Evaluate the spatial calibration profile using the 

following criteria:

Select one

Start spatial calibration

Spatial calibration profile for 3130xl system

Spatial calibration profile for 3130 system

Peak
Attribute Acceptable Criteria

Height Similar heights for all peaks.

Orange
crosses

One orange cross marking the top 
of every peak. No misplaced 
crosses.

Shape Single sharp peak for each 
capillary.

Small shoulders are acceptable.

Spacing The difference between adjacent 
positions is 13 to 16 pixels. 
Theoretical spacing between 
capillaries is 15.
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Notes

2. Examine each row in the 16 or 4 Capillary 
Positions table and verify that the values in both 
the Left spacing and Right spacing columns 
range between 13 to 16 pixels.

To move the cross: 

a. Type a new value in the Positions (pixels) 
box for the capillary of interest. 

b. Click outside of that box or press Enter.

Accepting or Rejecting a Spatial 
Calibration

If the calibration:

• Passed, click  to write the 
calibration data to the database and .ini file.

• Failed, click , then see the Applied 
Biosystems 3130/3130xl Genetic Analyzers 
Maintenance, Troubleshooting and 
Reference Guide.

Left spacing and 
Right spacing 
columns

Accept and 
Reject buttons
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Notes

2

Examples of Spatial Profiles

Passing Profiles 3130 Genetic Analyzer

3130xl Genetic Analyzer

Failing Profile 3130xl Genetic Analyzer
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Notes

Chapter 3

3

Performing a Spectral Calibration

Prepare spectral
calibration chemistry

Create a spectral
instrument protocol

Perform a spectral
calibration

Activate a spectral
calibration

Evaluate the spectral
calibration data

Performing a
Spectral Calibration

Autoanalysis
and Sequencing
Analysis 
Software

Autoanalysis
and
Fragment Analysis

Autoanalysis
and
SeqScape Software

Running the
Instrument

Preparing the
Instrument

Performing a
Spatial Calibration

See page 37

See page 43

See page 47

See page 35

See page 31
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Notes

Spectral Calibration
A spectral calibration creates a matrix that is used during a run to reduce raw data from 
the instrument to the 4-dye or 5-dye data stored in sample files. Performing a spectral 
calibration is similar to performing a sample run except that calibration standards are run 
in place of samples and a spectral calibration module is used in place of a run module.

When to Perform
the Calibration

Perform a spectral calibration:

• When you use a new dye set on the instrument

• When you change capillary array length (or polymer type for fragment analysis)

• After the laser or CCD camera has been realigned/replaced by a service engineer

• If you begin to see a decrease in spectral separation (pull-up and/or pull-down 
peaks) in the raw or analyzed data

What Happens? Run the spectral standards in all 16 or 4 capillaries. The Data Collection software then:

• Collects the data and stores it in 16 or 4 separate temporary files

• Analyzes the data and generates a matrix for each capillary

• Stores the spectral calibration data for the dye set run

Changing
Capillary Array

Lengths and
Polymer Type

For each dye set, a unique spectral calibration is used for each different capillary array 
length. 

• For every sequencing dye set, you must create a separate spectral calibration for 
each capillary array length you use.

• For every fragment analysis dye set, you must create a separate spectral calibration 
for each capillary array length and polymer type combination you use.

See “Activating a Spectral Calibration” on page 47, on how to switch calibrations once 
calibrations are performed for each dye set on each capillary length.

Supported
Sequencing
Chemistries

New basecaller, mobility files, and run modules will be developed for the 3130/3130xl 
series instruments solely in support of the ABI PRISM® BigDye® Terminator v1.1 and 
v3.1chemistry kits. For more information, please contact Applied Biosystems Technical 
Support.

ABI PRISM® BigDye® Terminator v1.0, v2.0 and v3.0 chemistry kits have been 
discontinued.
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Notes

3

Types of
Calibration
Standards

There are two types of spectral calibration standards:

• Matrix standards for fragment analysis or sequencing - A tube that contains 
four or five fragments each labeled with a different single dye.

• BigDye® v3.1 or BigDye® v1.1 Terminator Sequencing Standard - A tube of a standard 
chemistry reaction that contains multiple labeled fragments in each of the four dyes

Dye Set Tables Determine the correct dye set and matrix standard set for the application you are using 
by using the tables below.

Sequencing Chemistry Dye Sets, Calibration Standards, and Chemistry File

Sequencing Chemistry Dye Set Spectral Calibration Standard Chemistry File

• BigDye® Terminator v3.1 Cycle 
Sequencing Kit

• ABI PRISM® dGTP BigDye® 
Terminator v 3.0 Cycle Sequencing 
Ready Reaction Kita

Z_BigDyeV3 BigDye® v3.1 Matrix Standards Matrix Standard

BigDye® v3.1 Terminator 
Sequencing Standard

Sequence Standard

• BigDye® Terminator v1.1 Cycle 
Sequencing Kit

• ABI PRISM® BigDye® Primer Cycle 
Sequencing Kits

• ABI PRISM® dGTP BigDye® 
Terminator Cycle Sequencing Ready 
Reaction Kita

E_BigDyeV1 DS-01 Matrix Standards Matrix Standard

BigDye® v1.1 Terminator 
Sequencing Standard

Sequence Standard

ABI PRISM® dRhodamine Terminator 
Cycle Sequencing Kit

dRhodamine Matrix Standards Kit Matrix Standard

a dGTP kits are not supported on capillary electrophoresis instruments due to compressions on certain sequence context regions; you can 
run the kits if compression is not an issue.
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Fragment Analysis Dye Sets, Calibration Standards, and Chemistry File

Fragment Analysis Chemistry Dye Set Spectral Calibration Standard Chemistry File

Custom oligos D DS-30 Matrix Standards Matrix Standard

• ABI PRISM® Mouse Mapping Set v1.0

• Custom oligos

D DS-31 Matrix Standards

• AFLP® kits

• Stockmarks® Kits 4-dye (bovine and 
canine)

• AmpFlSTR® COfiler® Kit

• AmpFlSTR® Profiler Plus® Kit

• AmpFlSTR® Profiler Plus® ID Kit

• AmpFlSTR® SGM Plus® Kit

• Other 4-Dye AmpFlSTR Kits

F DS-32 Matrix Standards

 ABI PRISM® SNaPshot® Multiplex System E5 DS-02 Matrix Standards

• ABI PRISM® Linkage Mapping Set v2.5

• Stockmarks® Kit 5-dye (equine)

• Custom Oligos

• AmpFlSTR® Identifiler® Kit

• AmpFlSTR® SEfiler™ Kit

• AmpFlSTR® Yfiler™ Kit

• Other 5-Dye AmpFlSTR Kits

G5 DS-33 Matrix Standards
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Preparing the Spectral Calibration Chemistry
Preparing the Calibration Standard

1. Prepare one of the following:

CHEMICAL HAZARD. 
Formamide causes eye, skin, and respiratory 
tract irritation. It is a possible reproductive and 
birth defect hazard. Read the MSDS, and follow 
the handling instructions. Wear appropriate 
protective eyewear, clothing, and gloves.

• ABI PRISM BigDye Terminator v1.1 or v3.1 
Sequencing Standard:

– Remove a tube of the Sequencing 
Standard from the freezer.

– Add 170 µL of Hi-Di™ formamide to 
resuspend the BigDye Terminator v1.1 or 
v3.1 Sequencing Standard.

• Sequencing or fragment analysis matrix 
standards:

– Remove a tube of the matrix standard 
from the refrigerator.

– Mix thoroughly, then spin briefly in a 
microcentrifuge.

– Follow the matrix standard insert for 
matrix standard and Hi-Di formamide 
ratios.

2. Vortex thoroughly.
Briefly centrifuge the mixture.

3. Heat the standard tube at 95 °C for 5 minutes to 
denature the DNA. 

4. Cool the tubes on ice for 2 minutes.

00:00:05

Vortex

00:00:05

<1500×g

00:05:00

95 °C

00:02:00

0 °C
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Loading Samples

CHEMICAL HAZARD. All 
chemicals on the instrument, including liquid in the 
lines, are potentially hazardous. Please read the 
MSDS, and follow the handling instructions. Wear 
appropriate eyewear, protective clothing, and gloves 
when working on the instrument.

 Do not use warped 
or damaged plates.

Note: The efficient way to lay out samples in a plate 
is illustrated here. See Appendix A, “Plate Mapping,” 
for the relationship between sample position and 
priority in scheduled injections.

To load samples:

1. Add the denatured samples to the wells of a 96-
or 384-well reaction plate:

• If using a 3130xl genetic analyzer:

– 96-well plate – Add 10 µL of denatured 
standard to wells A1 through H2.

– 384-well plate – Add 5 µL of denatured 
standard into alternating wells of the 
plate:

Row 1: A1, C1, E1, …K1, M1, O1

Row 2: Empty

Row 3: A3, C3, E3, …K3, M3, O3

• If using 3130 genetic analyzer:

– 96-well plate – Add 10 µL of denatured 
standard to wells A1, B1, C1 and D1.

– 384-well plate – Add 5 µL of denatured 
standard into alternating wells of the 
plate: 

Row 1: A1, C1, E1 and G1

GR1315c

A

B

C

D

E

F

G

H

1 2 3 4 5 6 7 8 9 10 11 12

GR1316c

A

B

C

D

E

F

G

H

I

J

K

L

M

N

O

P

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24

Prepared standard 
(from step 4 on page 31)

96-Well
Plate

Add 10 µL prepared standard 

384-Well
Plate

Add 5 µL prepared standard 
into alternating wells 

3130
instrument

layout

3130xl
instrument

layout

3130
instrument

layout

3130xl
instrument

layout
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2. Seal the plate:

a. Place the plate on a clean, level surface.

b. Lay the septa flat on the plate.

c. Align the holes in the septa strip with the 
wells of the plate, then firmly press 
downward onto the plate.

IMPORTANT!: Do not heat plates that are 
sealed with septa.

3. To prevent damage to the capillary array, inspect 
the plate and septa to verify the septa fits snugly 
and flush on the plate.

4. Briefly centrifuge the plate.

5. Remove the plate from the centrifuge and verify 
that each sample is positioned correctly in the 
bottom of its well.

If the reagents of any well contain bubbles or are 
not located at the bottom of the well, repeat 
steps 4 and 5.

6. Leave the plate on ice until you are ready to 
prepare the plate assembly and place the 
assembly on the autosampler.

Plate septa

Sample plate

Septa and well 
not aligned

Septa and well 
not aligned

0:05<1500 × g

Prepared standard

Sample is at the 
bottom of the well
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7. Assemble the plate assembly:

a. Place the sample plate into the plate base. 

b. Snap the plate retainer onto the plate and 
plate base.

8. Verify that the holes of the plate retainer and the 
septa strip are aligned. If not, re-assemble the 
plate assembly (see step 7).

IMPORTANT! Damage to the array tips will 
occur if the plate retainer and septa strip holes do 
not align correctly.

G
R

20
50

b

Assembled 
components 

6a
6b

Plate base

Plate retainer

Plate retainer 
holes and septa 
holes are not 
aligned
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Creating a Spectral Instrument Protocol
1. In the tree pane of the Data Collection software, 

click GA Instruments > ga3130xl or 
ga3130 > Protocol Manager to open the 
Protocol Manager window.

2. In the Instrument Protocols pane, click . 
The Protocol Editor dialog box opens.

3. Complete the Protocol Editor dialog box.

a. Type a name for the protocol.

b. Type a description for the protocol 
(optional).

c. Select Spectral in the Type drop-down list.

d. Select the correct dye set for your run. See 
“Dye Set Tables” on page 29.

Create instrument 
protocols here

Create analysis 
protocols here

3a

3b

3c

3d

3e

3f

3g

3h
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e. Select the Polymer and Array Length from 
the appropriate drop-down list. See table, 
“Polymer, Array Length and Spectral Run 
Modules.” 

f. Select your chemistry file in the Chemistry 
drop-down list. Failure to select the correct 
chemistry file for your spectral calibration 
samples results in a failing spectral run. See 
“Dye Set Tables” on page 29 for matching 
chemistry files.

Note: The chemistry file for fragment 
analysis dye sets defaults to the Matrix 
Standard.

g. In the Run Module drop-down list, select 
the run module. See the table “Polymer, 
Array Length and Spectral Run Modules.”

Note:  The modules list is filtered based on 
the polymer type, then the array length you 
selected in step e. You may have only one 
run module option available.

h. Click .

Polymer, Array Length and Spectral Run Modules

Polymer
Type

Array
Length (cm) Run Module

POP-4 22 Spect22_POP4

36 Spect36_POP4

SpectSQ36_POP4

50 Spect50_POP4

80 Spect80_POP4

POP-6 36 Spect36_POP6

50 Spect50_POP6

POP-7 36 Spect36_POP7

50 Spect50_POP7

80 Spect80_POP7
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Performing a Spectral Calibration

Creating the Plate Record

1. In the tree pane of the Data Collection software, 
click GA Instruments > ga3130xl or 
3130 > instrument name > Plate 
Manager.

2. Click  to open the New Plate dialog 
box.

3. Complete the New Plate dialog box:

a. Enter a name for the plate.

b. Optional: Enter a description for the plate 
record.

c. In the Application drop-down list, select 
Spectral Calibration. 

d. In the Plate Type drop-down list, select 96-
Well or 384-Well

e. Enter a name for the owner.

f. Enter a name for the operator.

g. Click .

4. In the Spectral Calibration Plate Editor dialog 
box:

a. In the Sample Name column, enter a sample 
name, then click the next cell. The value 
100 automatically displays in the Priority 
column.

b. Optional: In the Comments column, enter 
any additional comments or notations for 
the sample at the corresponding position of 
the plate.

c. In the Instrument Protocol 1 column, select 
a protocol from the list or create a new 
protocol (see step 2 on page 35)

5. Highlight the entire row.

Plate Manager

3a

3b

3c

3d

3e

3f

3g

4a 4b 4c
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6. Select Edit > Fill Down Special.
Based on your plate type (96- or 384-well) and 
capillary array (16 or 4 capillaries), the software 
automatically fills in the appropriate well 
numbers for a single run.

7. Click . 

You have successfully created the plate record 
for the spectral calibration plate.
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Placing the Plate Assembly into the 
Instrument

1. Verify the oven and front doors are closed.

2. Press the Tray button and wait for the 
autosampler to stop at the forward position.

3. Open the front doors.

4. Place the plate assembly on the autosampler in 
position A or B for the 3130xl genetic analyzer 
and position B for the 3130 genetic analyzer.

Note: There is only one orientation for the plate, 
with the notched end of the plate base away 
from you.

5. Ensure the plate assembly fits flat in the 
autosampler. Failure to do so may allow the 
capillary tips to lift the plate assembly off of the 
autosampler.

6. Close the instrument doors.

Note: Closing the doors returns the autosampler 
to the home position, placing the tips of the 
capillaries in buffer.

G
R

21
42

G
R

21
42

3130 genetic analyzer 

3130xl genetic analyzer

BA

B
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Running the Spectral Calibration Plate 

1. In the tree pane of the Data Collection software, 
click GA Instruments > ga3130xl or 
3130 > instrument name > Run 
Scheduler > Plate View.

2. Search for your plate record. There are two 
options:

• Select Barcode in the Type of Search drop-
down list.

– In the Scan or Type Plate ID text box, 
type in the plate name and click Search 
to find the plate.

– Or if you have a limited number of plates 
in the database, click . 

All plates in the database display in plate 
record section.

• Perform an advanced search by selecting 
Advanced in the Type of Search drop-down 
list.

– Use the drop-down list to define search 
conditions for a category or multiple 
categories (Run Name, Results Group 
Name, Plate Name, etc.)

Note: Your entry for Plate Name will also 
be set as the Plate ID.

– For each category with a condition 
selected, type a value (primary search 
string) in the Value 1 column.

– Click . All plates in the database 
that match the search criteria display in 
the plate record section.
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.3. Link the plate.

a. Select the plate record you want to run.

b. Click the plate position indicator that 
matches the plate you want linked.

The plate map color will change from 
yellow to green when it is successfully 
linked.

Note: The 3130 genetic analyzer has only 
one plate position (Bay B) to link a plate 
record.

4. In the toolbar of the Data Collection software 
window, click  to begin the run.

5. The Processing Plates dialog box opens. Click 
.

Note: The instrument may pause before running 
the plate to raise the oven temperature.

Spectral Calibration Approximate Run 
Times

3a

3b

Capillary Length 
(cm) Run Type Ramp Time

(min)
Approximate Total Run 

Time (min)

22 Spec22_POP4 3 21

36 Spec36_POP4 10 35

SpecSQ36_POP4 10 48

Spec36_POP6 10 54

Spec36_POP7 5 30

50 Spec50_POP4 7.5 110

Spec50_POP6 10 95

Spec50_POP7 7.5 52

80 Spec80_POP4 10 140

Spec80_POP7 10 120
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Viewing the Pass/Fail Status After the Run

After the spectral calibration run, the pass or fail 
status of each capillary is recorded in the Event Log 
section of the Instrument Status window.

1. In the tree pane of the Data Collection software, 
click GA Instruments > ga3130xl or 
ga3130 > instrument name >

Instrument Status > Event Log.

2. In the Event Messages section of the window, 
view the status of each capillary.

Note: The window below shows the dye set G5 
status results.

Each capillary should have a Q-value above 0.95 
and a Condition number range shown in the 
table.

Note: If the entire spectral calibration failed, see 
the Applied Biosystems 3130/3130xl Genetic 
Analyzers Maintenance, Troubleshooting and 
Reference Guide for troubleshooting 
information.

Cap # Pass/fail status Q-value Condition Number

Dye Set
Acceptable 
Condition 

Number Range
Q-Value

Sequencing Analysis 0.95

Z_BigDyeV3 3 to 5

E_BigDyeV1

Fragment Analysis

D 4 to 8.5

F 6 to 12

E5 2.5 to 4

G5 8.5 to 14.5

Any 4- or 5-Dye 
set 

1 to 20 0.80
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Evaluating the Spectral Calibration Data

IMPORTANT! Evaluate the spectral calibration profile 
for each capillary, even if the Spectral Calibration 
Results box indicates that they passed. 

Note: Pages 49 to 50 for examples of passing 
sequencing spectral calibration profiles. See pages 51 
to 52 for examples of passing fragment analysis 
spectral calibration profiles. 

Evaluating the Spectral Profile and Raw 
Data

1. In the tree pane of the Data Collection software, 
click GA Instruments > ga3130xl or 
ga3130 > instrument name > Spectral 
Viewer.

Spectral 
profile

View, rename, 
or set the 
active 
spectral 
calibration for 
the selected 
dye set

Raw data 
(matrix 
standards)

Plate diagram

Click each cell 
to verify the 
spectral profile 
and raw data



D
R

A
FT

N
ov

em
b

er
 1

6,
 2

00
4 

2:
09

 p
m

, 0
3_

S
p

ec
tr

al
C

al
.fm

Chapter 3 Performing a Spectral Calibration
Evaluating the Spectral Calibration Data

44 Applied Biosystems 3130/3130xl Genetic Analyzers Getting Started Guide

Notes

2. In the Dye Set drop-down list, select the dye set 
you just created.

Note: If the spectral calibration failed (no 
spectral profiles are created), see the Applied 
Biosystems 3130/3130xl Genetic Analyzers 
Maintenance, Troubleshooting and Reference 
Guide for more information. 

3. In the plate diagram, select a well on the plate 
diagram to view the capillary spectral results.

Note: A failing capillary is automatically 
assigned the spectral profile of its nearest passing 
capillary. 

4. Evaluate the spectral profile and raw data for the 
selected capillary:

a. Verify that the order of the peaks in the 
spectral profile from left to right are:

– 4-dye: blue-green-yellow-red

– 5-dye: blue-green-yellow-red-orange

Passed (dark green)

Passed well elected (light green)

Failed (tan)

Capillary status:

Well A1

Failed well selected (light tan)

Blue Green Yellow Red

Example of a 4-dye spectral profile

Blue Green Yellow Red Orange

Example of a 5-dye spectral calibration profile

Do the peaks in 
the profile appear 

in the correct 
order?

Then

Yes Go to step b.

No The calibration run 
has failed. See the 
Applied 
Biosystems 
3130/3130xl 
Genetic Analyzers 
Maintenance, 
Troubleshooting, 
and Reference 
Guide.
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b. Verify that the order of the peaks in the raw 
data profile from left to right are:

Sequencing

– 4-dye: red-yellow-blue-green

Fragment Analysis

– 4-dye: red-yellow-green-blue

– 5-dye: orange-red-yellow-green-blue

c. Verify that the peaks in the spectral profile 
do not contain gross overlaps, dips, or other 
irregularities (see “Magnifying the Spectral 
Profile or Raw Data” on page 46).

Example of a 4-dye sequencing raw data profile

Example of a 5-dye fragment analysis raw data profile

Orange

Red

BlueGreenRed Yellow 

Blue GreenYellow

Are peaks in the 
wrong order or 
extraneous 
peaks adversely 
affecting the 
spectral profile?

Then

Yes The calibration run 
has failed. See the 
Applied 
Biosystems 
3130/3130xl 
Genetic Analyzers 
Maintenance, 
Troubleshooting, 
and Reference 
Guide.

No Go to step c.

Peaks are distinct, regular and in the proper order – pass

Red peak is not distinct, regular or in the proper order – fail

Are the peaks 
separate and 

distinct?
Then

Yes The capillary has 
passed. Go to 
step 5.

No The calibration run 
has failed. See the 
Applied 
Biosystems 
3130/3130xl 
Genetic Analyzers 
Maintenance, 
Troubleshooting, 
and Reference 
Guide.
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5. Repeat steps 3 and 4 for each capillary in the 
array.

6. Optional: Rename the spectral run. The spectral 
file default name is the day, date, and time of the 
run.

a. Click .

b. In the Rename Calibration dialog box, enter 
a descriptive name for the spectral 
calibration including the dye set, array 
length and polymer type (optional).

c. Click .

 Magnifying the Spectral Profile or Raw Data

1. In the tree pane of the Data Collection 
software, click 

GA Instruments > ga3130xl or 
ga3130 > instrument 
name > Spectral Viewer.

2. In the spectral profile or raw data display, 
click-drag the cursor to create a box 
around the area of interest.

3. Release the mouse button. 

The Data Collection software displays the 
selected region.

4. Press r to reset the view.

Selecting an area to magnify in a spectral profile

Magnified area of that spectral profile
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Activating a Spectral Calibration

IMPORTANT! A run cannot start unless a calibration file that matches the dye set and 
capillary array length combination to be used for the run, is active.

IMPORTANT! While the software does not force you to recalibrate spectrally after 
changing polymer types, it is strongly recommended that you perform a spectral 
calibration after a polymer type change.

IMPORTANT! Whenever you install or replace an array or switch dye sets, you must 
either set the active spectral calibration for that dye set and array length combination or 
perform a new spectral calibration and then activate it.

IMPORTANT! Every new spectral calibration is automatically the active one for that dye 
set. 

You may activate a previously created spectral calibration for a run as long as the 
calibration matches the dye set and array length combination (and, for fragment analysis, 
the polymer type) that you wish to use. Use an active spectral calibration for:

• Sequencing analysis applications that require a separate spectral calibration (for the 
same dye set) for different capillary array lengths and polymer type

• Fragment analysis applications that require a separate spectral calibration (for the 
same dye set) for different capillary array lengths and polymer type

• Repeat spectral calibrations where the original calibration is better than the second 
one

Setting an Active
Spectral

Calibration

1. In the tree pane of the Data Collection software, click 
GA Instruments > ga3130xl or ga3130 > instrument 

name > Spectral Viewer.

IMPORTANT! If the Spectral Viewer window is blank and deactivated, then either:
–The spectral calibration for that dye set is not in the database
or, 
–You changed the array length and you do not have a spectral calibration file 
activated for that dye set and array length combination.

2. In the Dye Set drop-down list, select a dye set.
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3. In the List of Calibrations for Dye Set drop-down 
list, select the spectral calibration you want to 
use. The spectral profile and raw data is 
displayed.

4. If the spectral calibration is acceptable, then click 
. Otherwise, run a new spectral calibration.
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Examples of Passing Sequencing Spectral Calibrations

Dye Set Z Created
from Matrix

Standard

Dye Set Z Created
from a

Sequencing
Standard
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Dye Set E Created
from Matrix

Standard Set
DS-01

Dye Set E Created
from a

Sequencing
Standard
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Examples of Passing Fragment Analysis Spectral 
Calibrations

Dye Set G5
Created from

Matrix Standard
Set DS-33

Dye Set F Created
from Matrix

Standard Set
DS-32
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Dye Set D
Created from

Matrix Standard
Set DS-30

Dye Set E5
Created from

Matrix Standard
Set DS-02
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Chapter 4

4

Autoanalysis and
Sequencing Analysis Software

Autoanalysis 
and Sequencing 
Analysis 
Software

Create protocols
for automated

sequencing analysis

Create a
Sequencing Analysis

Plate Record

Autoanalysis
and
Fragment Analysis

Autoanalysis
and
SeqScape Software

Running the
Instrument

Preparing the
Instrument

Performing a
Spatial Calibration

Performing a
Spectral Calibration

See page 59

See page 77
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Sequencing Analysis Software

See the Applied Biosystems DNA Sequencing Analysis Software v5.1 User Guide 
(P/N 4346366) for details on sequencing analysis or the Sequencing Analysis 
Software v5.2 User Bulletin titled New Features (P/N 4358355) for an update on 
Sequencing Analysis Software v5.2.

Analyze your sequencing samples automatically using autoanalysis or manually.

Autoanalysis Perform autoanalysis of sequencing samples using features of the 3130/3130xl genetic 
analyzer Data Collection software and Sequencing Analysis Software v5.2 or higher. 

The Sequencing Analysis Software must be installed and registered with the 
3130/3130xl genetic analyzer Data Collection software before you can create files 
required for autoanalysis. 

Autoanalysis can only be performed on the same computer that collected the sample 
files. If you perform autoanalysis on samples, but wish to edit/review results on another 
computer, transfer the analysis protocol to the Sequencing Analysis Software database. 
To analyze samples on another computer, transfer the files to that location.

Manual Analysis If the run is not set up for autoanalysis, see the Applied Biosystems DNA Sequencing 
Analysis Software v5.1 User Guide and the Sequencing Analysis Software v5.2 User 
Bulletin - New Features. 

File-Naming
Convention

Some alphanumeric characters are not valid for user names or file names. Do not use the 
characters below:

spaces 

\ / : * ? " < > | 

IMPORTANT! An error message is displayed if you use any of these characters. You 
must remove the invalid character to continue.
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About Plate Records and Sequencing Analysis

Overview Plate records are data tables in the instrument database that contain the following 
information:

• Plate name, type, and owner

• Position of the sample on the plate (well number)

• Sample Name

• Mobility file (in Analysis Protocol)

• Comments about the plate and about individual samples

• Name of the run module and Dye set information (run modules specify the 
conditions to run the samples) 

• Name of the Analysis Protocol

Note: A plate record is similar to a sample sheet or an injection list that you may have 
used with other ABI PRISM® instruments. 

When to Create a
Plate Record

Create a plate record for each plate of samples for the following types of runs: 

• Spectral calibrations

• Sequencing Analysis Software

• SeqScape Software analysis

• GeneMapper® software

• Mixed (sequencing and fragment analysis samples - see the Applied Biosystems 
3130/3130xl Genetic Analyzers Maintenance, Troubleshooting, and Reference 
Guide for creating a mixed plate record) 

For runs to begin, you must create a plate record for and link it to a plate loaded on the 
instrument. However, you can create plate records for new plates while a run is in 
progress.

About a
Sequencing

Analysis Plate
Record

The Plate Editor displays an empty plate record for the application selected in the New 
Plate dialog box. The data fields within a given plate record vary depending on the 
selected application. This section describes the sequencing analysis plate record’s data 
fields.

The table below describes required plate editor fields:

Parameters Description See Page

Instrument Protocol Contains the run module and dye set needed to run the 
instrument.

59

Analysis Protocol Contains everything needed to analyze sequencing 
data.

62

Results Group Defines the file type, the file name, file save locations, 
analysis software and autoanalysis.

70
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Elements of a Sequencing Analysis Plate Record

IMPORTANT! For data collection and autoanalysis to succeed, each run of samples must 
have an Instrument Protocol, an Analysis Protocol, and a Results Group assigned within 
a plate record.

Results Group
 Name

Analysis software 
and autoanalysis

Plate Record

Plate Manager

Results Group

Basecaller and 
DyeSet/Primer file

Bases called
(pure or mixed)

Assigning Quality  
Values (QVs)

Post processing  
(clear range
 trimming)

Analysis Protocol

Instrument 
Protocol Name

Run type 
(Regular)

Instrument Protocol

Run module

Dye set

File storage 
location

File and run folder
name preferences

Analysis Protocol
 Name
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A Blank
Sequencing

Analysis Plate
Record

Columns inserted in a plate record for a sequencing analysis run 

Number and 
Column Description

1. Sample Name  Name of the sample

2. Comment Comments about the sample (optional)

3. Priority A default value of 100 to each sample. Changing the value to a 
smaller number increases the priority of that set of 16 or 4 samples to 
run before the others in the injection list.

4. Results Group Some options:

• New: Opens the Results Group Editor dialog box

• Edit: Opens the Results Group Editor dialog box for the Results 
Group listed in the cell

• None: Sets the cell to have no selected Results Group

• Select one of the available Results groups from the list

Note: You must have a Results Group selected for each sample 
entered in the Sample Name column.

See “Results Group for Sequencing Analysis” on page 70.

1 2 3 4 5 6

Default is one sample run, to add 
additional runs see page 79
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5. Instrument 
Protocol

• New: Opens the Protocol Editor dialog box. 

• Edit: Opens the Protocol Editor dialog box for the Instrument 
Protocol listed in the cell.

• None: Sets the cell to have no selected protocol.

• List of Instrument Protocols: In alpha-numeric order.

Note: You must have an Instrument Protocol selected for each 
sample entered in the Sample Name column.

See “Instrument Protocol for Sequencing Analysis” on page 59.

6. Analysis Protocol • New: Opens the Analysis Protocol Editor dialog box. 

• Edit: Opens the Analysis Protocol Editor dialog box for the 
Instrument Protocol listed in the cell. 

• None: Sets the cell to have no selected protocol.

• List of Analysis Protocols: In alpha-numeric order 

Note: You must have an Analysis Protocol selected for each sample 
entered in the Sample Name column.

See “Analysis Protocol for Sequencing Analysis” on page 62.

Number and 
Column Description
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Creating Protocols for Automated Sequencing Analysis
If the appropriate instrument protocol, analysis 
protocol, and results group have been created, proceed 
to “Filling Out a Sequencing Analysis Plate Record” 
on page 77. 

Instrument Protocol for Sequencing Analysis

An instrument protocol contains all the settings 
necessary to run the instrument: the protocol name, 
type of run, run module, and dye set.

 Do not edit the instrument 
protocol currently being used, while the instrument is 
running.

Creating an Instrument Protocol

1. In the tree pane of the Data Collection software, 
click GA Instruments > ga3130xl or 
ga3130 > Protocol Manager.

Create instrument 
protocols here

Create analysis 
protocols here
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2. In the Instrument Protocol section, click 
.

The Protocol Editor opens. 

3. Complete the Protocol Editor:

a. Type a name for the protocol.

b. Type a description for the protocol 
(optional).

c. Select Regular in the Type drop-down list.

d. Select the correct run module for your run. 
See “Sequencing Resolution Performance 
and Specifications” on page 3. 

Note: To customize a run module, see the 
Applied Biosystems 3130/3130xl Genetic 
Analyzers Maintenance, Troubleshooting, 
and Reference Guide. 

3a

3b

3c
3d

3e

3f
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e. Select the correct Dye Set for your run by 
using the table below. 

f. Click .

Importing an Instrument Protocol

1. Click  in the Instrument Protocols pane 
of the Protocol Editor window to display the 
standard File Import dialog box.

2. Navigate to the location of the .xml file you want 
to import.

3. Select the .xml file and click Open.

Exporting an Instrument Protocol

1. In the Instrument Protocols pane, highlight the 
protocol you want to export.

2. Click  to display the standard File 
Export dialog box.

3. Browse to the desired folder location.

4. Click .

POP-4 
Polymer

POP-6 
Polymer POP-7 Polymer

Chemistry Dye Set

U
lt

ra
S

eq
36

S
td

S
eq

50

Lo
ng

S
eq

80

R
ap

id
S

eq
36

S
td

S
eq

50

U
lt

ra
S

eq
36

R
ap

id
S

eq
36

Fa
st

S
eq

50

S
td

S
eq

50

Lo
ng

S
eq

80

BigDye® Terminator v3.1 Cycle Sequencing Kit Z_BigDye
V3

✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓

ABI PRISM® dGTP BigDye® Terminator v3.0 
Cycle Sequencing Ready Reaction Kit

— — — — — — — — — —

BigDye® Terminator v1.1 Cycle Sequencing Kit E_BigDye
V1

✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓

ABI PRISM® dGTP BigDye® Terminator Cycle 
Sequencing Kit*

— — — — — — — — — —

ABI PRISM® dRhodamine Dye Terminator 
Cycle Sequencing Ready Reaction Kit

✓ ✓ ✓ ✓ ✓ — — — — —

ABI PRISM® BigDye® Primer Cycle Sequencing 
Kits

— — — ✓ ✓ — — — — —

*dGTP kits are not supported on capillary electrophoresis instruments due to compressions on certain sequence context regions; you can 
run the kits if you do not care about the compression issues.
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Analysis Protocol for Sequencing Analysis
An analysis protocol contains all the settings 
necessary for analysis and post processing: 

• Protocol name – The name, description of the 
analysis protocol, and the sequence file formats 
to be used

• Basecalling settings – The basecaller, 
DyeSet/Primer file, and analysis stop point to be 
used

• Mixed Bases (Optional) – When two bases are 
found at the same position. Define the percent 
value of the second highest to the highest peak

• Clear Range – The high quality sequence 
remaining after trimming low quality sequences 
typically found at the beginning and ends of the 
sequence. The clear range can be based on base 
positions, sample quality values, and/or number 
of ambiguities (Ns) present

Note: If you created an appropriate analysis protocol 
in the Sequencing Analysis software, you can use it in 
Data Collection software. 

IMPORTANT! Do not delete an analysis protocol 
during a run while it is being used for that run. 
Autoanalysis will not be performed if you do so.

Creating an Analysis Protocol

See the Applied Biosystems DNA Sequencing Analysis 
Software v5.2 User Guide (P/N 4346366) for more 
information on analysis protocols.

1. In the Analysis Protocol section of the Protocol 
Manager, click .

If more than one analysis application is installed 
on the data collection computer, the Analysis 
Applications dialog box opens.

Note: When you name your analysis protocol, 
assign a version name to help you distinguish 
your analysis protocols.
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2. Select Sequencing Analysis, then click  
to open the Analysis Protocol Editor dialog box.

3. In the General tab:

a. Enter a unique name and description for the 
new protocol.

b. Select the appropriate Sequence File 
formats settings.

3a

3b

Option Creates…

Write .Seq File
check box

A .seq file for printing the 
sequence as text file or for 
use in other software.

• Use ABI format with 
Applied Biosystems 
software.

• Use FASTA format with 
other software.

Write Standard 
Chromatogram 
Format file 
(.scf)

A .scf file to use with other 
software. When created, 
the .scf extension is not 
appended to the file name. 

Write Phred 
(.phd.1) File

A .phd.1 file to use with 
other software if you used 
the KB™ basecaller.
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4. Select the Basecalling tab.

a. See “3130/3130xl Genetic Analyzer 
Basecaller and DyeSet/Primer Files” on 
page 66 to select your basecaller and 
DyeSet primer file.

Note:  Sequencing Analysis Software and 
3130/3130xl genetic analyzer Data 
Collection software filter .mob file choices 
to match the chosen .bcp file.

b. In the Processed data pane, select True or 
Flat Profile.

c. If desired, select one or more stop points for 
data analysis. 

d. Select your Threshold Quality option.

4c

4d

4a

4b

Option Used to display data as processed traces scaled...

Uniformly - the average height of peaks in the region of strongest signal is about 
equal to a fixed value. The profile of the processed traces will be very similar to 
that of the raw traces.

Semi-locally - the average height of peaks in any region is about equal to a fixed 
value. The profile of the processed traces will be flat on an intermediate scale (> 
about 40 bases).

Note: This option is applied to data that is analyzed with the KB™ basecaller 
only. If you use the ABI basecaller, the profile option reverts to True Profile.

Option Function

With the KB™ basecaller, use this setting to assign a base to every 
position, as well as the QV.

With the KB basecaller, use this setting to assign Ns to base with 
QVs less than the set point. The QV is still displayed.



D
R

A
FT

N
ov

em
b

er
 3

, 2
00

4 
9:

51
 a

m
, 0

4_
S

W
S

et
up

_S
eq

.fm
Chapter 4 Autoanalysis and Sequencing Analysis Software

Analysis Protocol for Sequencing Analysis

Applied Biosystems 3130/3130xl Genetic Analyzers Getting Started Guide 65

Notes

4

5. Select the Mixed Bases tab.

Note: This function is active with the KB 
Basecaller only.

a. For mixed bases only, select Use Mixed 
Base Identification. 

b. Use the default setting of 25% or change the 
detection level by entering a new value or 
dragging the % line up or down.

Note: Do not use less than 15% as your 
detection limit.

6. Select the Clear Range tab.

Note: The clear range is the region of sequence 
that remains after excluding the low-quality or 
error prone sequence at both the 5´ and 3´ ends.

Select one or more Clear Range methods. If you 
apply multiple methods, the smallest clear range 
results.

7. Click  to save the protocol and close the 
Sequence Analysis Protocol Editor dialog box.

5a

5b

Use with 
KB Basecaller

Use with ABI and 
KB Basecallers

Use with ABI and 
KB Basecallers
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3130/3130xl Genetic Analyzer Basecaller and DyeSet/Primer Files

Basecaller and DyeSet/Primer Files Used with BigDye® Terminator Chemistry and KB Basecalling

DNA Sequencing 
Chemistry Polymer KB Basecalling Run 

Module DyeSet/Primer Basecaller

BigDye® Terminator v1.1 
Cycle Sequencing Kit

POP-4™ UltraSeq36_POP4 KB_3130_POP4_BDTv1.mob KB.bcp

StdSeq50_POP4

LongSeq80_POP4

POP-6™ RapidSeq36_POP6 KB_3130_POP6_BDTv1.mob

StdSeq50_POP6

POP-7™ UltraSeq36_POP7 KB_3130_POP7_BDTv1.mob

RapidSeq36_POP7

FastSeq50_POP7

StdSeq50_POP7

LongSeq80_POP7

BigDye® Terminator v3.1 
Cycle Sequencing Kit

POP-4 UltraSeq36_POP4 KB_3130_POP4_BDTv3_.mob

StdSeq50_POP4

LongSeq80_POP4

POP-6 RapidSeq36_POP6 KB_3130_POP6_BDTv3.mob

StdSeq50_POP6

POP-7 UltraSeq36_POP7 KB_3130_POP7_BDTv3.mob

RapidSeq36_POP7

FastSeq50_POP7

StdSeq50_POP7

LongSeq80_POP7

Basecaller and DyeSet/Primer Files Used with BigDye® Terminator Chemistry and ABI Basecalling

DNA 
Sequencing 
Chemistry

Polymer ABI Basecalling Run 
Module Basecaller DyeSet/Primer

BigDye® 
Terminator v1.1 
Kit

POP-4™ UltraSeq36_POP4 Basecaller-
3130POP4UR.bcp

DT3130POP4LR{BD}v1.
mob

LongSeq80_POP4 Basecaller-
3130POP4_80cmv3.bcp

POP-6™ RapidSeq36_POP6 Basecaller-
3130POP6RRv2.bcp

DT3130POP6{BD}v2.mob

StdSeq50_POP6 Basecaller-
3130POP6SR.bcp
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Dye Primer Chemistry 

BigDye 
Terminator v3.1 
Cycle 
Sequencing Kit

POP-4 UltraSeq36_POP4 Basecaller-
3130POP4UR.bcp

DT3130POP4{BDv3}v1.m
ob

LongSeq80_POP4 Basecaller-
3130POP4_80cmv3.bcp

POP-6 RapidSeq36_POP6 Basecaller-
3130POP6RRv2.bcp

DT3130POP6{BDv3}v1.m
ob

StdSeq50_POP6 Basecaller-
3130POP6SRv2.bcp

ABI PRISM® 
dRhodamine 
Dye Terminator 
Cycle 
Sequencing 
Ready Reaction 
Kit

POP-4 UltraSeq36_POP4 Basecaller-
3130APOP4UR.bcp

DT3130POP4{dRhod}v2.
mob

LongSeq80_POP4 Basecaller-
3130POP4_80cmv3.bcp

POP-6 RapidSeq36_POP6 Basecaller-
3130POP6RRv2.bcp

DT3130POP6{dRhod}v2.
mob

StdSeq50_POP6 Basecaller-
3130POP6SR.bcp

Basecaller and DyeSet/Primer Files Used with BigDye® Terminator Chemistry and ABI Basecalling (continued)

Basecaller and DyeSet/Primer Files Used for Dye Primer Chemistry

DNA 
Sequencing 
Chemistry

Polymer ABI Basecalling Run 
Module Basecaller DyeSet/Primer

ABI PRISM® 
BigDye® Primer 
Cycle 
Sequencing Kit

POP-6 RapidSeq36_POP6 Basecaller-
3130POP6RRv2.bcp

DP3130POP6{BD
-21M13}v1.mob

StdSeq50_POP6 Basecaller-
3130POP6SR.bcp

DP3130POP6{BD
-21M13Rev}v1.mob
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Editing and Deleting Analysis Protocols

Editing an Analysis Protocol

1. In the Analysis Protocols pane in the Analysis 
Protocol Manager, highlight the protocol you 
want to edit.

2.  Click .

3. Make changes in the General, Basecalling, 
Mixed Bases and Clear Range tabs, if 
appropriate.

4. Click  to save the protocol and close the 
Analysis Protocol Editor dialog box.

Deleting an Analysis Protocol

IMPORTANT! Do not delete an analysis protocol 
during a run while it is being used for that run. 
Autoanalysis will not be performed if you do so. You 
must first delete any plate records using the analysis 
protocol before you can delete or modify the 
analysis protocol for these plate records. 

1. In the Analysis Protocols pane in the Analysis 
Protocol Manager, highlight the protocol you 
want to delete.

2. Click  to display the Deletion 
Confirmation dialog box.

3. Click .
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Exporting an Analysis Protocol

1. In the Analysis Protocols pane in the Analysis 
Protocol Manager, highlight the protocol you 
want to export.

2. Click  to display the standard File 
Export dialog box.

3. Browse to the desired folder location.

4. Click Save.

Importing an Analysis Protocol

1. Click  to display the standard File 
Import dialog box.

2. Browse for the .xml file to import and click 
Open.

Note: For multiple applications, select the 
appropriate application to associate with the 
analysis protocol.
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Results Group for Sequencing Analysis
A Results Group is a component within Data 
Collection that organizes samples and certain user 
settings under a single name. It is called a Results 
Group because it is used to name, sort, and deliver 
samples that result from a run. 

Creating a Results Group 

1. In the tree pane of the Data Collection software, 
click GA Instruments > Results Group.

2. Click  to display the Results Group Editor 
window.

3. Complete the General tab:

a. Type a unique Results Group Name. The 
name can be used in grouping sample files. 

b. Type a Results Group Owner (optional). 
The owner name can be used in naming and 
sorting sample files.

c. Type a Results Group Comment (optional).
3a
3b
3c
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4. Select the Analysis tab, then:

a. Select Sequencing Analysis from the 
Analysis Type drop-down list.

b. In the Analysis Actions section, select Do 
Autoanalysis, if you want your data 
automatically analyzed after a run.

Note: Login ID and password are not 
required for Sequencing Analysis software.

5. Select the Destination tab, then use the default 
destination or define a new location for data 
storage.

a. Click Use Custom Location, then click 
 to navigate to a different save 

location.

b. Click  to test the Location path 
name connection:

4b

4a

5a

5b
5c

To use … Then …

default location* skip to step 6.

custom location complete steps a-b.

If it… Then a message box 
displays …

Passes Test succeeded: 
<“path”>.

Fails Test failed:<“path”>.

*Sample File Destinations

Locations where sample files are placed during extraction:

• Default Destination, default folder naming: E:\AppliedBiosystemsUDC\DataCollection\data\<instrument type>\
<instrument name>\run folder

• Default Destination, custom folder naming: E:\AppliedBiosystemsUDC\DataCollection\data\top custom folder\ 
subfolders, etc.

• Custom Destination, default folder naming: Destination\<instrument type>\<instrument name>\run folder

• Custom Destination, custom folder naming: Destination\top customer folder\subfolders, etc.
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6. Select the Naming tab.

Use the Naming tab to customize sample file and 
run folder names. You have two options:

• Use the default names for the folder and 
sample file.

• Use custom names for the folder and sample 
file. See “Optional: Completing Sample File 
Name Format Pane” on page 73 for 
elements of the Naming tab. 

Note: Sample name, run folder name, and path 
name, combined, can total no more than 250 
characters. 

Sample 
File Name 
Format pane

Run Folder 
Name 
Format pane
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Optional: Completing Sample File Name 
Format Pane

Note: The default sample file naming for sequencing 
analysis is: 
seq_<capillary number>_<wellposition>.ab1

1. Select the Naming tab.

2. Type a prefix for the file name in the Prefix box. 
Your entry is shown in the Example line. 

3. Select the symbol that separates the Format 
elements in the file name from the Name 
Delimiter drop-down list. Only one delimiter 
symbol may be chosen.

4. Click the Format list and then select the 
components that you want in the sample name. 

Note: All the samples from a single run can be 
placed in the same run or results folder, so the 
name of every sample from a single run should 
be different. Most of the Format options are not 
different between samples, so select at least one 
of the options that make the sample names 
unique within a run. 
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If a unique identifier is not included in the name, 
a warning message displays. Select from the 
elements to make a unique sample file name. 
Examples are:

– Well position 

– Capillary number

– Run sequence number

– Plate Quadrant

Note: some identifiers, such as well position, 
capillary number and plate quadrant are not 
unique in multiple sample instances. Plate 
Quadrant is not a unique identifier for a 96-well 
plate.

As you select the elements for the file name, they 
are placed in the Example line. An additional 
element drop-down menu displays allowing you 
the option of selecting an additional element.

The names of the Format elements eventually 
truncate, but the Example field remains visible 
(up to 72 characters).

Warning message

Note: Resize the Results 
Group window horizontally 
to view the element options.
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5. Type the suffix for the file name in the Suffix 
box.

Note: The File Extension field displays the file 
extension generated from the Analysis Type 
specified on the Analysis tab (see page 71). For 
example, Sequencing Analysis produces sample 
files with an .ab1 extension.

Optional: Run Folder/Sub-Folder Name 
Format Pane

Note: The default run folder naming for sequencing 
analysis is Run_<Instrumentname>_<Dateand 
TimeofRun>_<RunSeq#>.

Follow the same steps described for the Sample File 
Name Format pane (see page 73) to change the sub-
folder name within the run folder. Make the sub-
folder name unique, such as using the Run Folder 
name.

Saving a Results Group

Click  from any tab once all the elements 
within the Results Group have been chosen.

Note: Even if you create a custom run folder location, 
the system generates a separate default run folder that 
contains the log file.

Importing and Exporting a Results Group

Results Groups can be imported from, or exported to, 
XML files allowing sharing of identical Results 
Groups between instruments.

Importing a Results Group

1. In the tree pane of the Data Collection software, 
click GA Instruments > Results Group.

2. Click  to display the standard File 
Import dialog box.



D
R

A
FT

N
ov

em
b

er
 3

, 2
00

4 
9:

51
 a

m
, 0

4_
S

W
S

et
up

_S
eq

.fm

Chapter 4 Autoanalysis and Sequencing Analysis Software
Results Group for Sequencing Analysis

76 Applied Biosystems 3130/3130xl Genetic Analyzers Getting Started Guide

Notes

3. Navigate to the file you want to import.

Note: Import file type is .xml (XML file).

4. Click .

Exporting a Results Group

1. In the tree pane of the Data Collection software, 
click GA Instruments > Results Group.

2. Click the Results Group name to select it.

3. Click .

A standard file export dialog box displays with 
the chosen Results Group name.

4. Navigate to the location where you want to save 
the exported file.

5. Click .

Note: If there is a name conflict with a Results 
Group that already exists at the save location, 
then duplicate the Results group. Duplication 
copies the settings into a similar Results Group 
without the risk of user error when copying it 
manually (see procedure below).

Duplicating a Results Group

1. Click the Results Group name.

2. Click . 

Note: When you duplicate a Results Group, you 
are asked to type a name for the new Results 
Group and for the analysis application type.
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Filling Out a Sequencing Analysis Plate Record

Creating a Sequencing Analysis Plate 
Record

1. In the tree pane of the Data Collection software, 
click GA Instruments > ga3130xl or 
ga3130 > Plate Manager.

2. Click to display the New Plate Dialog 
dialog box.

3. Complete the information in the New Plate 
Dialog:

a. Type a name for the plate.

b. Type a description for the plate (optional).

c. Select your sequencing application in the 
Application drop-down list.

d. Select 96-well or 384-well in the Plate Type 
drop-down list.

e. Type a name for the owner and operator.

f. Click  to open the Sequencing 
Analysis Plate Editor.

3a

3b

3c

3d

3e

3f

3f
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Completing a Sequencing Analysis Plate 
Record

1. In the Sample Name column of a row, enter a 
sample name, then click the next cell. The value 
100 automatically displays in the Priority 
column.

2. In the Comments column, enter any comments 
or notations for the sample.

3. In the Priority column, change the priority value, 
if desired. A lower number for each 4 or 16 set, 
receives a higher run priority.

4. In the Results Group 1 column, select a group 
from the drop-down list (see page 70) or create a 
new Results Group.

5. In the Instrument Protocol 1 column, select a 
protocol from the drop-down list (see page 59) or 
create a new instrument protocol.

6. In the Analysis Protocol 1 column, select a 
protocol from the drop-down list (see page 62) or 
create a new analysis protocol.

7. Complete the plate record based on the samples 
loaded in your plate:

• For the single runs that use the same 
samples and protocols – Highlight the entire 
row, then select Edit > Fill Down Special.
Based on your plate type (96- or 384-well) 
and capillary array (16 or 4 capillaries), the 
software automatically fills in the 
appropriate well numbers for a single run 

or

• For entire plates that use the same samples 
and protocols – Highlight the entire row, 
then select Edit > Fill Down to fill down 
the entire plate editor.

• For plates with different samples and 
protocols – complete the entries manually.

1 42 3

5 6
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8. To do more than one injection of the same 
sample, select Edit > Add Sample Run.

Results Group, Instrument Protocol and Analysis 
Protocol columns are added to the right end of 
the plate record.

9. Complete the columns for the additional runs.

10. Click .

Note: After clicking OK in the Plate Editor, the 
completed plate record is stored in the Plate 
Manager database.The plate record can be 
searched for, edited, duplicated, exported, or 
deleted in the Plate Manager.



D
R

A
FT

N
ov

em
b

er
 3

, 2
00

4 
9:

51
 a

m
, 0

4_
S

W
S

et
up

_S
eq

.fm

Chapter 4 Autoanalysis and Sequencing Analysis Software
Filling Out a Sequencing Analysis Plate Record

80 Applied Biosystems 3130/3130xl Genetic Analyzers Getting Started Guide

Notes



D
R

A
FT

N
ov

em
b

er
 3

, 2
00

4 
9:

51
 a

m
, 0

5_
S

W
S

et
up

_S
eq

S
ca

p
e.

fm

Applied Biosystems 3130/3130xl Genetic Analyzers Getting Started Guide 81

Notes

Chapter 5

5

Autoanalysis and
SeqScape Software

Autoanalysis 
and
SeqScape Software

Create protocols
for automated

SeqScape Software Analysis

Create a
SeqScape Software 

Plate Record

Autoanalysis
and
Fragment Analysis

Running the
Instrument

Preparing the
Instrument

Performing a
Spatial Calibration

Performing a
Spectral Calibration

Autoanalysis
and Sequencing
Analysis
Software

See page 88

See page 101
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SeqScape Software

Analyzing your sequencing samples may be done by autoanalysis or manual analysis.

Autoanalysis Use the ABI PRISM® SeqScape® software to automatically analyze Applied Biosystems 
3130/3130xl Genetic Analyzers sequencing data. Perform autoanalysis only on the same 
instrument computer that collected the sample files. You can configure the software 
packages to perform data collection and then data analysis without requiring user 
interaction. 

Install and register the SeqScape software with the 3130/3130xl genetic analyzer Data 
Collection software before creating required files for autoanalysis. 

See Appendix B in the SeqScape Software User Guide v2.5 (P/N 4359442), for more 
details on setting up autoanalysis.

Required
Software

Packages

Autoanalysis requires three software packages:

• 3130/3130xl genetic analyzer Data Collection software

The Data Collection software runs the instrument and collects fluorescent data from 
samples. For autoanalysis to occur, the software must communicate with 
downstream software.

Analysis parameters used for data collection as well as that created in SeqScape 
software are accessible in Data Collection software.

• Autoanalysis Manager

The Autoanalysis Manager software is part of the integration between the data 
collection, SeqScape, and GeneMapper® software. It can queue messages and track 
their processing status. Each message is considered a batch job, whether it contains 
a single sample, samples from a result group, or an entire run of samples.

Autoanalysis Manager is installed by Seqscape or GeneMapper software when 
loaded on a system with Data Collection software.

• A version of SeqScape software without a user interface

This SeqScape software version is identical to the regular software version except 
that there is no user interface. The Autoanalysis Manager opens and uses this 
version of software to analyze the data in the projects.

The automated processing version and the standard version of SeqScape software 
are installed from the SeqScape Software installation CD.

IMPORTANT! When installing SeqScape software on a computer that is connected to a 
3130/3130xl genetic analyzer, the Data Collection software must be running. Otherwise, 
the SeqScape software does not register with the Data Service. See Chapter 2 in the 
SeqScape Software User Guide v2.5, for information on installing the software.
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Importing Reports
and Projects After

Autoanalysis

In the SeqScape Software v2.5, select Tools > Options tab.You can set the options to 
automatically import:

• Reports after autoanalysis

• Projects after autoanalysis

See the SeqScape Software User Guide v2.5 (P/N 4359442) for more details.

File-Naming
Convention

Some alphanumeric characters are not valid for user names or file names. Do not use the 
invalid characters below:

spaces 

\ / : * ? " < > | 

IMPORTANT! An error message is displayed if you use any of these characters. You 
must remove the invalid character to continue.

Manual Analysis See the SeqScape Software User Guide v2.5 (P/N 4359442) for information on 
performing manual analysis.

About Plate Records and Seqscape Software

Requirements Successful automatic analysis requires that:

• SeqScape software is installed properly

• SeqScape software is registered and the appropriate user IDs have been created

• Autoanalysis Manager software is running

• The 3130/3130xl genetic analyzer is set up to run, and samples are prepared

• Files for a Data Collection software plate record are available:

– An instrument protocol

– An analysis protocol

– A results group assigned within a plate record

When to Create a
Plate Record

Create a plate record for each plate of samples for the following types of runs: 

• Spectral calibrations

• Sequencing Analysis Software

• SeqScape Software analysis

• GeneMapper® software

• Mixed (sequencing and fragment analysis samples - see the Applied Biosystems 
3130/3130xl Genetic Analyzers Maintenance, Troubleshooting and Reference 
Guide for creating a mixed plate record) 
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For runs to begin, you must create a plate record for and link it to a plate loaded on the 
instrument. However, you can create plate records for new plates while a run is in 
progress.

SeqScape
Software Plate

Record Overview

The Plate Editor displays an empty plate record for the application selected in the New 
Plate dialog box. The data fields within a given plate record vary depending on the 
application. This section describes the SeqScape Plate Record’s data fields.

IMPORTANT! For data collection and SeqScape software autoanalysis to succeed, each 
run of samples must have an instrument protocol, an analysis protocol, and a results 
group assigned within a plate record. You are also required to have a project, project 
template, and specimen information. 

The table below describes required plate editor fields.

Parameters Description See Page

Instrument Protocol Contains the run module and dye set needed to run 
the instrument. 

Created in Data Collection software.

88

Analysis Protocol Contains everything needed to analyze sequencing 
data.

Created in Data Collection software or SeqScape 
software. If you prefer to use analysis protocols 
created in SeqScape software, then select “Always 
use this protocol” - in the SeqScape software 
analysis defaults settings.

92

Results Group Defines the file type, the file name, file save locations, 
default analysis protocols linked to sample injections, 
and user name and password. 

Created in Data Collection software.

98

Project A group of related sequences that share the same 
reference or for which there is no explicit reference.

See the 
SeqScape 
Software 

User Guide 
v2.5 for more 
information

Project Template Contains a reference data group (RDG), analysis 
defaults, and display settings.

Specimen The container that holds all the sample data as 
assembled contigs from a biological source or PCR 
product
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Elements of a
SeqScape Plate

Record

Results Group
 Name

Analysis software 
and autoanalysis

Plate Record

Plate Manager

Results Group

Basecaller and 
DyeSet/Primer file

Bases called
(pure or mixed)

Assigning Quality 
Values (QVs)

Post processing
(clear range  
  trimming)

Analysis Protocol*

Instrument 
Protocol Name

Run type 
(Regular)

Instrument Protocol

Run module

Dye set

File storage 
location

File and run folder
name preferences

Analysis Protocol 
Name

Filter settings

Project 

Specimen

SeqScape software 
files:

Project Template
- Analysis Protocol*
- Analysis Defaults
- RDG
- Display Settings

*You can create Analysis Protocols in either
   SeqScape or Data Colletion software

Data Collection 
software files:



D
R

A
FT

N
ov

em
b

er
 3

, 2
00

4 
9:

51
 a

m
, 0

5_
S

W
S

et
up

_S
eq

S
ca

p
e.

fm

Chapter 5 Autoanalysis and SeqScape Software
About Plate Records and Seqscape Software

86 Applied Biosystems 3130/3130xl Genetic Analyzers Getting Started Guide

Notes

SeqScape
Software Plate

Record

A Seqscape software plate record displaying the columns and descriptions is shown 
below.

Number and Column Description

1. Sample Name Name of the sample.

2. Comment Comments about the sample (optional).

3. Priority A default value of 100 to each sample. Changing the value to a smaller number 
causes that set of 16 or 4 samples to run to before the others in the injection list.

4. Project Select one of the available Project from the list that was created in Data Collection or 
SeqScape software.

5. Project Template Completed automatically based on the Project selected.

6. Specimen Select one of the available Specimen from the list that was created in Data 
Collection or SeqScape software.

1 2 4 5 7 83 6 9

Default is one sample run, to add runs 
see page 103
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7. Results Group Some options:

• New: Opens the Results Group Editor dialog box

• Edit: Opens the Results Group Editor dialog box for the Results Group listed in 
the cell

• None: Sets the cell to have no selected Results Group

• Select one of the available Results groups from the list

Note: You must have a Results Group selected for each sample entered in the 
Sample Name column.

See “Creating a Results Group” on page 98.

8. Instrument Protocol • New: Opens the Protocol Editor dialog box. 

• Edit: Opens the Protocol Editor dialog box for the Instrument Protocol listed in 
the cell.

• None: Sets the cell to have no selected protocol.

• List of Instrument Protocols: In alpha-numeric order.

Note: You must have an Instrument Protocol selected for each sample entered in 
the Sample Name column.

See “Creating an Instrument Protocol” on page 88.

9. Analysis Protocol • New: Opens the Analysis Protocol Editor dialog box. 

• Edit: Opens the Analysis Protocol Editor dialog box for the Instrument Protocol 
listed in the cell. 

• None: Sets the cell to have no selected protocol.

• List of Analysis Protocols: In alpha-numeric order 

Note: You must have an Analysis Protocol selected for each sample entered in the 
Sample Name column.

See “Creating an Analysis Protocol” on page 93.

Number and Column Description
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Creating Protocols for Automated SeqScape Software 
Analysis
If the appropriate SeqScape software protocols and 
results group have been created, proceed to “Filling 
Out a SeqScape Software Plate Record” on page 101. 

Instrument Protocol for SeqScape Software

An instrument protocol contains all the necessary 
settings to run the instrument: 

• Protocol name 

• Type of run

• Run module

• Dye set

Creating an Instrument Protocol

1. In the tree pane of the Data Collection software, 
click GA Instruments > ga3130 or 
ga3130xl > Protocol Manager.

2. In the Instrument Protocols section, click 
 to open the Protocol Editor. 

Create 
instrument 

Create analysis 
protocols here
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3. Complete the Protocol Editor:

a. Type a name for the protocol.

b. Type a description for the protocol 
(optional).

c. Select Regular in the Type drop-down list.

d. Select the correct run module for your run. 
See “Sequencing Resolution Performance 
and Specifications” on page 3 to see a list of 
modules or the Applied Biosystems 
3130/3130xl Genetic Analyzers 
Maintenance, Troubleshooting and 
Reference Guide to modify a default 
module.

3a

3b

3c

3d

3e

3f
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e. Select the correct Dye Set for your run using 
the table below.

f. Click .

POP-4 
Polymer

POP-6 
Polymer POP-7 Polymer

Chemistry Dye Set

U
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36
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td
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eq

50
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BigDye® Terminator v3.1 Cycle Sequencing Kit Z_BigDye
V3

✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓

ABI PRISM® dGTP BigDye® Terminator v3.0 
Cycle Sequencing Ready Reaction Kit

— — — — — — — — — —

BigDye® Terminator v1.1 Cycle Sequencing Kit E_BigDye
V1

✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓

ABI PRISM® dGTP BigDye® Terminator Cycle 
Sequencing Kit*

— — — — — — — — — —

ABI PRISM® dRhodamine Dye Terminator Cycle 
Sequencing Ready Reaction Kit

✓ ✓ ✓ ✓ ✓ — — — — —

ABI PRISM® BigDye® Primer Cycle Sequencing 
Kits

— — — ✓ ✓ — — — — —

*dGTP kits are not supported on capillary electrophoresis instruments due to compressions on certain sequence context 
regions; you can run the kits if you do not care about the compression issues.
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Importing an Instrument Protocol

1. Click  in the Instrument Protocols pane 
of the Protocol Editor window to display the 
standard File Import dialog box.

2. Navigate to the location of the .xml file you want 
to import.

3. Select the .xml file and click Open.

Exporting an Instrument Protocol

1. In the Instrument Protocols pane, highlight the 
protocol you want to export.

2. Click  to display the standard File 
Export dialog box.

3. Browse to the desired folder location.

4. Click .
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Analysis Protocol for SeqScape Software

About Analysis
Protocols

An analysis protocol contains all the settings necessary for analysis and post processing: 

• Protocol name – The name, description of the analysis protocol, and the sequence 
file formats to be used

• Basecalling settings – The basecaller, DyeSet/Primer file, and analysis stop point 
to be used

• Mixed Bases – (Optional) – When two bases are found at the same position. Define 
the percent value of the second highest to the highest peak

• Clear Range – The high quality sequence remaining after trimming low quality 
sequences typically found at the beginning and ends of the sequence. The clear 
range can be based on base positions, sample quality values, and/or number of 
ambiguities (Ns) present

• Filter – The settings that define which samples will be used in the assembly

Note: If you created an appropriate analysis protocol in the SeqScape software, you can 
use it in the Data Collection software. See Appendix B in the SeqScape Software User 
Guide v2.5 (P/N 4359442) for more information on autoanalysis and analysis protocols.

IMPORTANT! Do not delete the current analysis protocol being used, during a run. 
Autoanalysis will not be performed if you do so.

IMPORTANT! You are required to select the Always use this Analysis Protocol in 
Analysis Defaults > Analysis Protocol in the Seqscape software if you want to use it for 
SeqScape analysis. See the SeqScape Software User Guide v2.5 (P/N 4359442) for more 
information.
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Creating an Analysis Protocol

IMPORTANT! If you created an appropriate analysis 
protocol in SeqScape software, you can use it in the 
Data Collection software. You can also create an 
analysis protocol in the SeqScape software.

1. In the Analysis Protocol section of the Protocol 
Manager, click .

If more than one analysis application is installed 
on the data collection computer, the Analysis 
Applications dialog box opens. 

2. Select SeqScape, then click  to open the 
Analysis Protocol Editor dialog box.

3. In the General tab, enter a unique name and 
description (optional) for the new protocol.
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4. Select the Basecalling tab, then:

a. Select the appropriate basecaller and 
DyeSet primer based on the chemistry, 
capillary array length and polymer type you 
are using. The dye set primer files displayed 
are based on the basecaller selected.
See “3130/3130xl Genetic Analyzer 
Basecaller and DyeSet/Primer Files” on 
page 66 for a table on basecallers and 
dyeset/primer files.

Note:  SeqScape Software and the Data 
Collection software filter .mob file choices 
to match the chosen .bcp file.

b. In the Processed data pane, select True or 
Flat Profile.

c. If desired, select one or more stop points for 
data analysis. 

d. Select your Threshold Quality option.

Option Function

Displays data as processed traces scaled uniformly. The average peak height in 
the region of strongest signal is about equal to a fixed value. The profile of the 
processed traces is similar to that of the raw traces.

Displays data as processed traces scaled semi-locally. The average peak height in 
any region is about equal to a fixed value. The profile of the processed traces is 
flat on an intermediate scale (> about 40 bases).

Note: This option is applied to data analyzed with the KB™ basecaller only. If you 
use the ABI basecaller, the profile option reverts to True Profile.

Option setting Function using KB basecaller

Assigns a base to every position, as well as the QV.

Assigns Ns to bases with QVs less than the set point. The QV will 
still be displayed.
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5. Select and fill in the Mixed Bases tab:

Note: This function is active with the KB 
basecaller only.

a. For mixed bases only, select Use Mixed 
Base Identification. 

b. Use the default setting of 25% or change the 
detection level by entering a new value or 
dragging the % line up or down.

Note: Do not use less than 15% as your 
detection limit.

6. Select the Clear Range tab, then, if desired, 
select one or more stop points for data analysis. 
Select the recommended settings, which are the 
default settings:

a. Use Quality values, fewer than 4 bases out 
of 20 have QVs less than 20.

b. Use reference trimming.

Note: The clear range is the region of the 
sequence that remains after excluding the low-
quality or error-prone sequence at both the 5´ and 
3´ ends.
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7. Select the Filter tab, then, if desired, change one 
or more of the settings.Select the recommended 
settings, which are the default settings:

a. Maximum Mixed Bases (%): 20
b. Maximum Ns (%): 10.0
c. Minimum Clear Length (bp): 50
d. Minimum Sample Score: 20

8. Click  to save the protocol and close the 
Analysis Protocol Editor dialog box.

Editing an Analysis Protocol

1. In the Analysis Protocols pane in the Analysis 
Protocol Manager, highlight the protocol you 
want to edit.

2.  Click .

3. Make changes in the General, Basecalling, 
Mixed Bases and Clear Range tabs, as 
appropriate.

4. Click  to save the protocol and close the 
Analysis Protocol Editor dialog box.
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Deleting an Analysis Protocol

IMPORTANT! Do not delete an analysis protocol 
during a run while it is being used for that run or 
Autoanalysis will not be performed. Also, you must 
first delete any plate records using the analysis 
protocol before you can delete or modify the 
analysis protocol for these plate records. 

1. In the Analysis Protocols pane in the Analysis 
Protocol Manager, highlight the protocol you 
want to delete.

2. Click .

The Deletion Confirmation dialog box displays.

3. Click .

Exporting an Analysis Protocol

1. In the Analysis Protocols pane in the Analysis 
Protocol Manager, highlight the protocol you 
want to export.

2. Click  to display the standard File 
Export dialog box.

3. Browse to the desired folder location.

4. Click Save.

Importing an Analysis Protocol

1. Click  to display the standard File 
Import dialog box.

2. Browse to the .xml file to import and click Open.

Note: For multiple applications, select the 
appropriate application to associate with the 
analysis protocol.
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Results Group for SeqScape Software

A Results Group is a component within Data 
Collection that organizes samples and certain user 
settings under a single name. It is called a Results 
Group because it is used to name, sort, and deliver 
samples that result from a run.

Creating a Results Group 

1. In the tree pane of the Data Collection software, 
click GA Instruments > Results Group.

2. Click . 

The Results Group Editor window displays.

3. Complete the General tab:

a. Type a Results Group Name. The name can 
be used in naming and sorting sample files. 
It must be unique (see page for a list of 
accepted characters).

b. Optional: Type a Results Group Owner. The 
owner name can be used in naming and 
sorting sample files.

c. Optional: Type a Results Group Comment.

4. Select the Analysis tab, then:

a. Select SeqScape_ computer name in the 
Analysis Type drop-down list.

b. Select Do Autoanalysis in the Analysis 
Actions section.

c. Type a valid SeqScape Software Login ID 
and Password in the text boxes.

Note: Failure to use the proper login and 
password causes your samples not to be 
analyzed automatically.

3a
3b
3c

4a

4b



D
R

A
FT

N
ov

em
b

er
 3

, 2
00

4 
9:

51
 a

m
, 0

5_
S

W
S

et
up

_S
eq

S
ca

p
e.

fm
Chapter 5 Autoanalysis and SeqScape Software

Creating Protocols for Automated SeqScape Software Analysis

Applied Biosystems 3130/3130xl Genetic Analyzers Getting Started Guide 99

Notes

5

5. Select the Destination tab, then use the default 
destination or define a new location for data 
storage.

a. Click Use Custom Location, then click 
 to navigate to a different save 

location.

b. Click  to test the Location path 
name connection:

6. Select the Naming tab, then define custom 
names for the sample file and the run folder 
name. See “Optional: Completing Sample File 
Name Format Pane” on page 73 for more 
detailed information.

7. Click  to save and close the Results 
Group Editor.

5a

5a
5b

To use … Then …

default location* skip to step 6

custom location complete steps a-c

If it… Then a message box 
displays …

Passes Test succeeded: 
<“path”>.

Fails Test failed:<“path”>.

*Sample File Destinations

Locations where sample files are placed during extraction:

• Default Destination, default folder naming: E:\AppliedBiosystemsUDC\DataCollection\data\<instrument type>\
<instrument name>\run folder

• Default Destination, custom folder naming: E:\AppliedBiosystemsUDC\DataCollection\data\top custom folder\ 
subfolders, etc.

• Custom Destination, default folder naming: Destination\<instrument type>\<instrument name>\run folder

• Custom Destination, custom folder naming: Destination\top customer folder\subfolders, etc.
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Importing and Exporting a Results Group

Note: Importing or exporting of SeqScape software 
Results Groups are not supported for transfer between 
separate computers.

1. In the tree pane of the Data Collection software, 
click GA Instruments > Results Group.

2. Click  to open a File Import dialog box.

3. Navigate to the file you want to import.

Note: Import file type is .xml (XML file).

4. Click .

Note:  When you import or duplicate a Results 
Group, you are asked to type a name for the new 
Results Group and for the analysis application 
type.

Exporting a Results Group

1. In the tree pane of the Data Collection software, 
click GA Instruments > Results Group.

2. Click the Results Group name to select it.

3. Click .

A standard File Export dialog box displays with 
the chosen Results Group name.

4. Navigate to the location where you want to save 
the exported file.

5. Click .

Note: If there is a name conflict with a Results 
Group that already exists at the save location, the 
Results groups can be duplicated to copy settings 
into a similar Results Group without the risk of 
user error when copying it manually (see 
“Duplicating a Results Group” on page 100).

Duplicating a Results Group

1. Click the Results Group to select it.
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2. Click . 

Note: When you import or duplicate a Results 
Group, you are asked to type a name for the new 
Results Group and for the analysis application 
type.

Filling Out a SeqScape Software Plate Record

Creating a SeqScape Software Plate 
Record

1. Click the Plate Manager icon in the navigation 
pane.

2. Click .

The New Plate Dialog dialog box opens.

3. Complete the New Plate dialog box:

a. Type a name for the plate.

b. Type a description for the plate (optional).

c. Select SeqScape_computer name in the 
Application drop-down list.

d. Select 96-well or 384-well in the Plate Type 
drop-down list.

e. Type a name for the owner.

f. Type a name for the operator.

g. Click . 

The SeqScape Plate Editor opens.

3a

3b

3c

3d

3e

3f

3g
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Completing a SeqScape Software Plate 
Record

1. In the Sample Name column of a row, enter a 
sample name, then click the next cell. The value 
100 automatically display in the Priority column.

2. In the Comments column, enter any additional 
comments or notations for the sample.

3. In the Priority column, change the priority value, 
if desired. A lower number for each 4 or 16 set, 
receives a higher run priority. (See the Applied 
Biosystems 3130/3130xl Maintenance, 
Troubleshooting, and Reference Guide for 
changing priority values).

4. In the Project column, select a project from the 
drop-down list or create a new project with the 
corresponding project template.

Based on the project you select, the project 
template is filled in automatically.

5. In the Specimen column, select or create a 
specimen.

6. In the Results Group 1 column, select a group 
from the drop-down list (see page 98).

7. In the Instrument Protocol 1 column of the row, 
select a protocol from the drop-down list (see 
page 88).

8. In the Analysis Protocol 1 column of the row, 
select a protocol from the drop-down list (see 
page 93).

9. To complete the rest of the plate record based on 
the samples loaded in your plate, do one of the 
following:

• For the same samples and protocols – 
Highlight the entire row, then select Edit > 
Fill Down Special.
Based your plate type (96- or 384-well) and 
capillary array (16 or 4 capillaries), the 
software automatically fills in the 
appropriate well numbers for a single run.

1 2 4 53

6 7 8
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• For the same samples and protocols – 
Highlight the entire row, then select Edit > 
Fill Down.

• For the different samples and protocols – 
Complete the entries manually.

10. If you want to do more than one run, then select 
Edit > Add Sample Run.

Additional Results Group, Instrument Protocol 
and Analysis Protocol columns are added to the 
right end of the plate record.

Add additional runs by selecting Edit > Add 
Sample Run again.

11. Complete the columns for the additional runs.

12. Click  to save, then close the plate record.

Note: After clicking OK within the Plate Editor, 
the completed plate record is stored in the Plate 
Manager database.The plate record can be 
searched for, edited, exported, or deleted in the 
Plate Manager.

For sample preparation and running the instrument, 
see Chapter 7, “Running the Instrument.” 
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Chapter 6

6

Autoanalysis and Fragment Analysis

Create protocols
for automation

Create a
GeneMapper Software  

Plate Record

Autoanalysis 
and
Fragment Analysis

Preparing the
Instrument

Performing a
Spatial Calibration

Performing a
Spectral Calibration

Autoanalysis
and Sequencing
Analysis
Software

Autoanalysis
and
SeqScape Software

Running the
Instrument

See page 123

See page 112
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GeneMapper Software

Analyze your fragment analysis samples automatically using autoanalysis or manually.

Note: This chapter is written for both GeneMapper® Software v3.7 or higher and 
GeneMapper® ID Software v3.2. Graphic examples are from GeneMapper software 
v3.7.

GeneMapper
Software v3.7 and

GeneMapper ID
Software v3.2

Perform autoanalysis of fragment analysis samples with features of the 3130/3130xl 
Data Collection and GeneMapper software using the same instrument computer that 
collected the sample files or on a remote computer.

• Autoanalysis can be performed on the same instrument computer that collected the 
sample files or on another computer using the remote analysis feature of 
GeneMapper software.

• After autoanalysis, if you wish to edit/review results on another computer, then 
transfer the GeneMapper software project, analysis methods, size standards, panel, 
and bin set information to the other GeneMapper software database. All 
components need to be exported and imported individually. 

• When completing the plate record, fill in the instrument protocol and other 
information for Data Collection software to complete the run. 

• When creating a new Results Group for a set of samples to be autoanalyzed, check 
the Do Autoanalysis check box and enter the appropriate GeneMapper Software 
user name and password. For remote analysis, define a default location for sample 
file storage.

File-Naming
Convention

Some alphanumeric characters are not valid for user names or file names. Do not use the 
invalid characters below:

spaces 

\ / : * ? " < > | 

IMPORTANT! An error message is displayed if you use any of these characters. You 
must remove the invalid character to continue.

Manual Analysis For information on manual analysis, see the GeneMapper Software v3.7 User Guide 
(PN 4359413) or GeneMapper ID Software V3.1 User Guide (PN 4338775), or the User 
Bulletin titled GeneMapper ID Software v3.2, Subject: New Features and Installation 
Procedures for GeneMapper ID Software v3.2 (PN 4352543).
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About Fragment
Analysis and Data

Collection

When GeneMapper software is installed on a computer that has 3130/3130xl genetic 
analyzer Data Collection software, two applications are available through the Results 
Group Editor (see page 115):

• GeneMapper-Generic

• GeneMapper-<Computer Name>

GeneMapper-
Generic

Use GeneMapper-Generic to generate .fsa files, without performing autoanalysis. When 
completing the Sample Sheet, fill in basic information for the Data Collection software 
to complete the run; all other GeneMapper software related fields are text entries. Text 
entries are useful if you are using other software analysis applications or choose to 
analyze your samples in GeneMapper software on another computer, but do not have the 
same entries in the GeneMapper software database stored on the Data Collection 
computer. For example, if you have a customized size standard definition on another 
GeneMapper software computer, you can type in that size standard name in the size 
standard text field and it will populate that column in your GeneMapper software 
project.

GeneMapper-
<Computer

Name>

Use GeneMapper-<Computer Name> for autoanalysis. The Size Standard, Analysis 
Method, and Panel columns in the Sample Sheet window read directly from the 
GeneMapper software database. Create these components in GeneMapper software prior 
to setting up the plate record for a run. New entries cannot be created for these columns 
once you are in the plate editor dialog box. If you create a new GeneMapper software 
component while the plate record dialog box is open, the columns will not update. The 
plate record must be closed and reopened to update the GeneMapper 
software components. For more information see, “Creating Protocols for Automated 
Fragment Analysis” on page 112.
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About GeneMapper Software Plate Records
A plate record is similar to a sample sheet or an injection list that you may have used 
with other ABI PRISM® instruments. 

Plate records are data tables in the instrument database that store information about the 
plates and the samples such as:

• Plate name, type, and owner

• Position of the sample on the plate (well number)

• Comments about the plate and about individual samples

• Dye set information (in Instrument protocol)

• Name of the run module where run modules specify information about how samples 
are run (in Instrument protocol)

When to Create a
Plate Record

Create a plate record for each plate of samples for the following types of runs: 

• Spectral calibrations

• Sequencing Analysis Software

• SeqScape Software analysis

• GeneMapper® software

• Mixed (sequencing and fragment analysis samples - see the Applied Biosystems 
3130/3130xl Genetic Analyzers Maintenance, Troubleshooting, and Reference 
Guide for creating a mixed plate record) 

For runs to begin, you must create a plate record for and link it to a plate loaded on the 
instrument. However, you can create plate records for new plates while a run is in 
progress.

Files needed to create a GeneMapper software plate record:

IMPORTANT! For data collection and auto-analysis to be successful, each run of 
samples must have an Instrument Protocol, a Results Group and files created in 
GeneMapper software assigned within a plate record.

Parameters Description See 
Page

Instrument 
Protocol

Contains everything needed to run the instrument. 112

Results Group Defines the file type, the file name, autoanalysis, and file save 
locations that are linked to sample injections.

115
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Elements of a GeneMapper software plate record

Plate Record

Plate Manager

Analysis method

Bin set

Panel

GeneMapper software 
definitions:

Size standard

SNP Set

Results Group
 Name

Analysis software 
and autoanalysis

Results Group

Instrument 
Protocol Name

Run type 
(Regular)

Instrument Protocol

Run module

Dye set

File storage 
location

File and run folder
name preferences

Data Collection 
software files:
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Blank GeneMapper software plate record

Columns inserted in a plate record for a fragment analysis run 

1 54 82 3 6 7 9 1110

Defaults to one sample run, to add additional runs see page 125

Number and Column Description

1. Sample Name Name of the sample

2. Comment Comments about the sample (optional)

3. Priority A default value of 100 to each sample. Changing the value to a 
smaller number causes that set of 16 or 4 samples to run to 
before the others in the injection list.

4. Sample Type Use to identify the sample as Sample, Positive Control, Allelic 
Ladder or Negative Control.

5. Size Standard

IMPORTANT! For GeneMapper-<Computer 
Name> ONLY: 

Create the Size Standard, Panel, and Analysis 
Method in GeneMapper software before creating a 
new plate

• GeneMapper-Generic (optional):

Manually enter size standards in the text field

• GeneMapper-<Computer Name>:

Select a saved size standard from the drop-down list

6. Panel 

IMPORTANT! For GeneMapper-<Computer 
Name> ONLY: 

Create the Size Standard, Panel, and Analysis 
Method in GeneMapper software before creating a 
new plate

• GeneMapper-Generic (optional):

Manually enter panels in the text field

• GeneMapper-<Computer Name>:

Select a saved panel from the drop-down list
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6

7. Analysis Method

IMPORTANT! For GeneMapper <Computer 
Name> ONLY: 

Create the Size Standard, Panel, and Analysis 
Method in GeneMapper software before creating a 
new plate

• GeneMapper-Generic (optional):

Manually enter analysis methods in the text field

• GeneMapper-<Computer Name>:

Select a saved analysis method from the drop-down list

8. SNP Set

IMPORTANT! For GeneMapper <Computer 
Name> ONLY: 

The SNP set, created in the GeneMapper software, 
links a SNP name to a marker name.

• GeneMapper-Generic (optional):

Manually enter SNP set in the text field

• GeneMapper-<Computer Name>

9. Three User-defined columns Optional text entries

10. Results Group Options:

• New: Opens the Results Group Editor dialog box

• Edit: Opens the Results Group Editor dialog box for the 
Results Group listed in the cell

• None: Sets the cell to have no selected Results Group

• Select one of the available Results groups from the list

Note: You must select a Results Group for each sample 
entered in the Sample Name column.

See “Results Group for Fragment Analysis” on page 115.

11. Instrument Protocol Options:

• New: Opens the Protocol Editor dialog box. 

• Edit: Opens the Protocol Editor dialog box for the 
Instrument Protocol listed in the cell.

• None: Sets the cell to have no selected protocol.

• List of Instrument Protocols: In alpha-numeric order.

Note: You must select an Instrument Protocol for each 
sample entered in the Sample Name column.

See “Results Group for Fragment Analysis” on page 115.

Number and Column Description
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Creating Protocols for Automated Fragment Analysis
If the appropriate fragment analysis protocols and 
results group have been created, proceed to “Creating 
a GeneMapper Software Plate Record” on page 123. 

Instrument Protocol for Fragment Analysis

An instrument protocol contains all the settings 
necessary to run the instrument:

• Protocol name

• Type of run

• Run module

• Dye set

Creating an Instrument Protocol

1. In the tree pane of the Data Collection software, 
click GA Instruments > ga3130xl or 
ga3130 > Protocol Manager.

2. In the Instrument Protocols section, click 
 to open the Protocol Editor. 

Create 
instrument 

Create analysis 
protocols here
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6

3. Complete the Protocol Editor:

a. Type a name for the protocol.

b. Type a description for the protocol 
(optional).

c. Select Regular in the Type drop-down list.

d. Using the table below, select the run module 
for your run. To customize a run module, 
see the Applied Biosystems 3130/3130xl 
Genetic Analyzers Maintenance, 
Troubleshooting, and Reference Guide on 
modifying a module.

3a

3b

3c
3d

3e

3f

Application or Kit
Capillary Array 

Length

(cm)
Run Module

SNaPshot® Multiplex System 22 SNP22_POP4_1

36 SNP36_POP4_1

• LMS v2.5

• ABI PRISM® Mouse Mapping 
Set v1.0

• Custom oligos

• Stockmarks

• AFLP®

22 FragmentAnalysis22_POP4_1

36 FragmentAnalysis36_POP4_1

FragmentAnalysis36_POP7_1

50 FragmentAnalysis50_POP4_1

FragmentAnalysis50_POP6_1

FragmentAnalysis50_POP7_1

• AmpFlSTR® COfiler® 

• AmpFlSTR Profiler Plus® 

• AmpFlSTR SGM Plus® 

• AmpFlSTR Profiler Plus ID 

• AmpFlSTR SEfiler™ 

• AmpFlSTR Yfiler™ 

• Other 4-Dye AmpFlSTR 

• AmpFlSTR Identifiler 

• Other 5-Dye AmpFlSTR 

36 HIDFragmentAnalysis36_POP4_1
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e. Using the table below, select the correct Dye 
Set for your run.

f. Click .

Importing an Instrument Protocol

1. Click  in the Instrument Protocols pane 
of the Protocol Editor window to display the 
standard File Import dialog box.

2. Navigate to the location of the .xml file you want 
to import.

3. Select the .xml file and click Open.

Application or Kit Dye Set Matrix Standard 
Set

Custom oligos D DS-30

• ABI PRISM Mouse Mapping Set v1.0

• Custom oligos

D DS-31

• AmpFlSTR COfiler 

• AmpFlSTR Profiler Plus 

• AmpFlSTR SGM Plus 

• AmpFlSTR Profiler Plus ID 

• Other 4-Dye AmpFlSTR 

• AFLP 

• Stockmarks -Canine and Bovine 

F DS-32

 ABI PRISM SNaPshot Multiplex System E5 DS-02

• ABI PRISM Linkage Mapping Set v2.5

• Custom Oligos

• AmpFlSTR Identifiler™ 

• AmpFlSTR SEfiler 

• AmpFlSTR Yfiler 

• Other 5-Dye AmpFlSTR 

• Stockmarks-Equine 

G5 DS-33
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6

Exporting an Instrument Protocol

1. In the Instrument Protocols pane, highlight the 
protocol you want to export.

2. Click  to display the standard File 
Export dialog box.

3. Browse to the desired folder location.

4. Click .

Results Group for Fragment Analysis

A Results Group is a component within Data 
Collection that organizes samples and certain user 
settings under a single name. It is called a Results 
Group because it is used to name, sort, and deliver 
samples that result from a run.

Creating a Results Group for Autoanalysis

1. In the tree pane of the Data Collection software, 
click GA Instruments > Results Group.

2. Click  to open the Results Group Editor 
window.
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3. Complete the General tab:

a. Type a unique Results Group Name. The 
name can be used in naming and sorting 
sample files.

b. Optional: Type a Results Group Owner. The 
owner name can be used in naming and 
sorting sample files.

c. Optional: Type a Results Group Comment.

4. Select the Analysis tab, then:

a. Click Analysis Type and then select one of 
the following:

3a
3b
3c

4a

4b

4c
4d

If You Select ... Then ...

None Only raw data files are 
generated.

GeneMapper-
Generic

Autoanalysis is not 
enabled and only .fsa files 
are generated.

GeneMapper-
<Computer 
Name>

Autoanalysis of completed 
runs is enabled.

Steps b, c, and d below 
apply only to 
GeneMapper-<Computer 
Name> (not GeneMapper-
Generic).
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b. Select an option in the Analysis Actions 
section using the table below.

c. Type the Login ID.

d. Type the login password.

Note: The login ID and password relate to the 
GeneMapper software UserName and Password. 
These items can only be created through the 
GeneMapper software Options Users tab. 
Autoanalysis will fail if the incorrect username 
and password are entered.

5. Select the Destination tab, then use the default 
destination or define a new location for data 
storage.

If You Select … Then … Use with Setting from Automated 
Processing Tab (page 118)

Do Autoanalysis Samples are analyzed after each run of 
16 or 4 samples.

When every run completes

Do Autoanalysis and 
Results Entry Group 
Complete

Samples are analyzed after all pending 
samples using the same results group 
have been run.

Only when the result group is complete

5a

5b

5c

To use a … Then …

default location* skip to step 6.

custom location 

Use for remote analysis 
using GeneMapper v3.7

complete steps a-b.

*Sample File Destinations

Locations where sample files are placed during extraction:

• Default Destination, default folder naming: E:\AppliedBiosystemsUDC\DataCollection\data\<instrument type>\
<instrument name>\run folder

• Default Destination, custom folder naming: E:\AppliedBiosystemsUDC\DataCollection\data\top custom folder\ 
subfolders, etc.

• Custom Destination, default folder naming: Destination\<instrument type>\<instrument name>\run folder

• Custom Destination, custom folder naming: Destination\top customer folder\subfolders, etc.
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a. Click Use Custom Location, then click 
 to navigate to a different save 

location.

b. Click  to test the Location path 
name connection:

6. Select the Naming tab to customize sample file 
and run folder names.

Note: The default sample file naming for 
fragment analysis is: 
frag_<capillary number>_<wellposition>.fsa

Note: Sample name, run folder name, and path 
name, combined, can total no more than 250 
characters.

For defining the elements of the Naming tab, see 
page 119.

7. Select the Automated Processing tab.

In “Autoanalysis is performed” select when you 
want your samples autoanalyzed using the table 
below.

8. Click  to save the Results Group. 

If it… Then a message box 
displays …

Passes Test succeeded: 
<“path”>.

Fails Test failed:<“path”>.

Sample File Name Format 

Run Folder Name Format pane

Select an 
autoanalysis 
option

If You Select … Then … Use with Settings from Analysis Tab
(page 117)

Only when the result group 
is complete

Samples are analyzed after all pending 
samples using the same results group 
have been run.

Do Autoanalysis and Results Entry 
Group Complete

When every run completes Samples are analyzed after each run of 
16 or 4 samples.

Do Autoanalysis
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Completing the Sample File Name Format Pane

1. Type a prefix for the file name in the Prefix box. 
Anything that you type here is shown in the 
Example line. 

2. Click the Name Delimiter list choose the 
symbol that will separate the Format elements in 
the file name (see step 3 below). Only one 
delimiter symbol may be chosen.

3. Click the Format list and then select the 
components that you want in the sample name. 

Note: All the samples from a single run can be 
placed in the same run or results folder; the name 
of every sample from a single run should be 
different. Most of the Format options will not be 
different between samples; select at least one of 
the options to make the sample names unique 
within a run.

If a unique identifier is not included in the name, 
a warning message displays.Select from the 
elements to make a unique sample file name. 
Examples are:

– Well position 

– Capillary number

– Run sequence number 

– Plate Quadrant

Note: Some identifiers, such as well position, 
capillary number and plate quadrant are not 
unique in multiple sample instances. Plate 
Quadrant is not a unique identifier for a 96-well 
plate.

Warning message
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As you select the elements for the file name, they 
are placed in the Example line. An additional 
element drop-down menu displays allowing you 
the option of selecting an additional element.

The names of the Format elements eventually 
truncate, but the Example field remains visible 
(up to 72 characters).

4. Click the Suffix box (optional) and type the 
suffix for the file name.

The File Extension field displays the file 
extension generated from the Analysis Type 
specified on the Analysis tab (see page 116). For 
example, Sequencing Analysis produces sample 
files with an .ab1 extension.

Run Folder/Sub-Folder Name Format Pane

Follow the same steps described above for the Sample 
File Name Format pane (see page 119) to change the 
sub-folder name within the run folder.
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Importing and Exporting a Results Group

Importing or exporting of GeneMapper software 
Results Groups are not supported for transfer between 
separate computers.

Importing a Results Group

1. In the tree pane of the Data Collection software, 
click GA Instruments > Results Group.

2. Click .

A standard File Import dialog box displays.

3. Navigate to the file you want to import.

Note: Import file type is .xml (XML file).

4. Click .

Note:  When you import or duplicate a Results 
Group, you are asked to type a name for the new 
Results Group and for the analysis application 
type.

Exporting a Results Group

1. In the tree pane of the Data Collection software, 
click GA Instruments > Results Group.

2. Click the Results Group name to select it.

3. Click .

A standard file export dialog box displays with 
the chosen Results Group name.

4. Navigate to the location where you want to save 
the exported file.

5. Click .

Note: If there is a name conflict with a Results 
Group that already exists at the save location, the 
Results groups can be duplicated in order to copy 
settings into a similar Results Group without the 
risk of user error when copying it manually (see 
“Duplicating a Results Group” on page 122).
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Duplicating a Results Group

1. Click the Results Group.

2. Click . 

Note: When you import or duplicate a Results 
Group, you are asked to type a name for the new 
Results Group and for the analysis application 
type.
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Creating a GeneMapper Software Plate Record

Creating the Plate Record for Autoanalysis

1. In the tree pane of the Data Collection software, 
click GA Instruments > ga3130xl or 
ga3130 > Plate Manager.

2. Click  to open New Plate Dialog.

3. Complete the information in the New Plate 
Dialog:

a. Type a name for the plate.

b. Type a description for the plate (optional).

c. Select your GeneMapper application in the 
Application drop-down list.

d. Select 96-well or 384-well in the Plate Type 
drop-down list.

e. Type a name for the owner. 

f. Type a name for the operator.

g. Click . 

The GeneMapper software Plate Editor 
opens.

3a

3b

3c

3d

3e

3f

3g
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Completing a GeneMapper Software Plate 
Record for Autoanalysis

1. In the Sample Name column of a row, enter a 
sample name, then click the next cell. The value 
100 automatically display in the Priority column.

2. In the Comment column, enter any additional 
comments or notations for the sample.

3. In the Priority column, change the priority value, 
if desired.

4. In the Sample Type column, select a sample type 
from the drop-down list. 

5. In the Size Standard column, select a size 
standard from the drop-down list.

6. In the Panel column, select a panel from the 
drop-down list.

7. In the Analysis Method column, select a method 
from the drop-down list.

8. In the Snp Set column, select a SNP set from the 
drop-down lis if applicable, otherwise select 
None.

9. Enter text for User-Defined columns 1 to 3.

10. In the Results Group 1 column, create a new 
Results Group or select a group from the drop-
down list (see page 115).

11. In the Instrument Protocol 1 column, create a 
new instrument protocol or select a protocol from 
the drop-down list (see page 112).

1 2 4 53

6 87 9

9 1110
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12. To complete the plate record:

• For the same samples and protocols – 
Highlight the entire row, then select Edit > 
Fill Down Special.
Based on your plate type (96- or 384-well) 
and capillary array (16 or 4 capillaries), the 
software automatically fills in the 
appropriate well numbers for a single run.

• For the same samples and protocols – 
Highlight the entire row, then select Edit > 
Fill Down.

• For the different samples and protocols – 
Complete the entries manually.

13. To do more than one run, select Edit > Add 
Sample Run.

Additional Results Group, Instrument Protocol 
and Analysis Protocol columns are added to the 
right end of the plate record.

Add additional runs by selecting Edit > Add 
Sample Run again.

14. Complete the columns for the additional runs.

15. Click  to save, then close the plate record.

IMPORTANT! After clicking OK in the Plate 
Editor, the plate record is stored in the Plate 
Manager database and can now be located, 
edited, exported, or deleted.
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Chapter 7

7

Running the Instrument

Heading 1text

Heading 1text

Heading 1text

Heading 1text

Heading 1text

Prepare samples and
plate assemblies

Place Plate onto
Autosampler

Link the Plate

Run the instrument

Set up for
continuous operation

Schedule a run

Running the
Instrument

Preparing the
Instrument

Performing a
Spatial Calibration

Performing a
Spectral Calibration

Autoanalysis
and Sequencing
Analysis
Software

Autoanalysis
and
Fragment Analysis

Autoanalysis
and
SeqScape Software

See page 130

See page 134

See page 129

See page 128

See page 128

See page 128
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Preparing Samples and Plate Assemblies

Review Table

Generalized sample preparation and plate assembly 
procedures are discussed in Chapter 3, “Performing a 
Spectral Calibration,” on page 27. 

Linking and Unlinking a Plate
Link a plate on the autosampler to your newly created 
plate record before running the plate.

Select the desired plate record, then click the plate 
position indicator corresponding to the plate position 
in the instrument. The plate position (A or B) displays 
in the link column.

Note: The 3130 genetic analyzer has only one plate 
position (B) to link a plate record.

The plate position indicator changes from yellow to 
green when linked and the green run button  
becomes active.

Topic... See

Sample Preparation “Preparing the Calibration Standard” on page 31 and “Loading 
Samples” on page 32 to review handling samples.

Follow your individual kit protocol to prepare sample load 
volume:

10 to 30 µL for a 96-well plate

5 to 15 µL for a 384-well plate

Sealing plates and plate assembly “Seal the plate:” on page 33.

Placing plate assemblies in the instrument “Placing the Plate Assembly into the Instrument” on page 39.

Searching for plate records to link to a plate “Running the Spectral Calibration Plate” on page 40.
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7

Unlinking a Plate Record

1. Click the plate record that you want to unlink.

2. Click . 

Viewing the Run Schedule

For more information on run scheduling and sample 
injection order, see “Plate Mapping” on page 161.

To verify that runs are scheduled correctly: 

1. In the tree pane of the Data Collection software, 
click GA Instruments > ga3130xl or 
ga3130 > instrument name > Run 
Scheduler > Run View.

2. Select a row for any run. The corresponding 
wells to be injected for that run are highlighted in 
the plate diagram.

2

1
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Running the Instrument

Starting the Run

1. Verify that the active spectral calibration matches 
your dye set and capillary array length for all 
scheduled runs.

To change the active spectral calibration, see 
“Activating a Spectral Calibration” on page 47.

To create a new spectral calibration, see 
“Creating a Spectral Instrument Protocol” on 
page 35.

2. Click the green button in the toolbar.

3. The Processing Plates dialog box opens, then 
click .

The software automatically performs a run 
validation:

• If the validation passes, the run starts

• If any of the validation test fails, the run 
does not start. Check the event log for 
information.
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Starting the Autoanalysis Manager for 
SeqScape and/or GeneMapper Software

Use the Autoanalysis Manager (AAM) software with 
SeqScape® and/or GeneMapper® software to 
automatically analyze the data.

1. Select Start > Programs > Applied Biosystems 
> Autoanalysis Manager > Autoanalysis 
Manager 3.0.

Note: Autoanalysis Manager does not start 
automatically. Open Autoanalysis Manager to 
receive messages from the data collection 
software for autoanalysis in SeqScape and/or 
GeneMapper software.

The Autoanalysis Manager window opens.

2. Quit the SeqScape and/or GeneMapper software.

No other interaction with the AAM software is 
needed until the runs finish. See “Using 
Autoanalysis Manager Software” on page 155 on 
how to use the Autoanalysis Manager.
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Notes

Basic Run Module
Steps

Automated module steps when the run starts 

To customize a run module, see the Applied Biosystems 3130/3130xl Genetic Analyzers 
Maintenance, Troubleshooting and Reference Guide.

Note: The PostBatch Utility, which runs automatically, turns off both the oven and the 
laser at end of a batch of runs.

DNA Sequencing
Run Times

Approximate run times of common DNA sequencing analysis runs

 Module Steps Approximate Time

Turn Oven On N/A

Wait for oven to equilibrate
Initialize autosampler

1 min 40 sec

Fill Array 3-4 min

PreRun 3 min

Inject samples 10 to 30 sec

Start separation
Ramp voltage

10 min

Collect Data Variable

Run ends: 
Leave oven on
Laser to idle

Until next run starts

Total time prior to separation:

• Oven unheated: ~25 min

• Oven at set temperature: ~6.5 min

 Type of Run Run Module Run Time (min)

Ultra rapid UltraSeq36_POP4 40 

UltraSeq36_POP7 35

Rapid RapidSeq36_POP6 60 

RapidSeq36_POP7

Fast FastSeq50_POP7 60 

Standard StdSeq50_POP4 100 

StdSeq50_POP6 150 

StdSeq50_POP7 120 

Long read LongSeq80_POP4 210 

LongSeq80_POP7 170 
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Notes

7

Fragment
Analysis Run

Times

Approximate run times of common fragment analysis runs

Controlling the Run 

Using the Toolbar Use the toolbar at the top of the data collection software window to control the run.

Type of Run Run Modules Run Time 
(min)

High Throughput, Small Size 
Fragment Analysis

FragmentAnalysis22_POP4 20

SNP22_POP4 20

Standard Fragment Analysis FragmentAnalysis36_POP4 45

HIDFragmentAnalysis36_POP4 45

SNP36_POP4 30

FragmentAnalysis36_POP7 35

FragmentAnalysis50_POP4 65

FragmentAnalysis50_POP6 90

FragmentAnalysis50_POP7 50

Click ... Description

Start Run

Starts the run

Stop

Stops the current run, and all other 
scheduled runs

Stop After Current Run

Completes the current run, then stops 
all other scheduled runs

Skip to Next Run

Stops the current run, then starts the 
other scheduled runs
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Notes

Set Up for Continuous Operation

Overview Use the continuous run feature to create and link a plate during a run. You can:

• Run one or more plates

• Remove the plate(s) once samples have run 

• Link and run additional plates

When using the continuous run feature:

• Only mount or unmount plates when the instrument is paused.

• Create the plate record before pausing the instrument to make linking more 
efficient, reducing long pauses.

• Link new plates after a run has resumed.

Adding or
Replacing a Plate

During a Run

During a run, you can mount and unmount plates while the instrument is paused. The 
plate record can be created, then linked after the run has been resumed.

If the plate is in use, see “Adding, Replacing, or Removing a Plate During a Run” on 
page 135.

IMPORTANT! Pausing the instrument for too long, especially after sample injection, will 
affect data quality. 

Pause Run

Pauses the current runa 

a Pausing the instrument for too long, especially after sample injection, will adversely 
affect data quality. 

Click ... Description
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Notes

7

Adding, Replacing, or Removing a Plate 
During a Run

Replace a completed plate or add a new plate to an 
unused plate bay (3130xl genetic analyzer only).

1. Prepare your plate and create the plate record.

2. Click  (Pause).

In the Pause dialog box, read the pause warning, 
then click  to pause the run.

The Resume run dialog box opens when the run 
is paused.

IMPORTANT! Do not click OK to resume the 
run. Temporarily ignore the dialog box.

3. Remove the old plate, if applicable.

a. Press the Tray button to bring the 
autosampler forward.

b. Open the instrument door.

c. Remove the old plate.

4. Mount the new plate.

5. Close the door.

6. Click OK in the Resume Run dialog box.

7. In the Completed Run dialog box, click  to 
continue if the samples have been injected, or 
click  to abort the run and return the 
instrument to an idle state.

IMPORTANT! If you click OK, the instrument 
will continue running the current run regardless 
of whether the samples have actually been 
injected or not. If the samples have not been 
injected, the samples will be injected from the 
new plate.
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Notes

8. Search for the plate record, then link the new 
plate.

The new plate runs after the current plate 
completes all scheduled injections.

Note: If you unmount the currently running 
plate prior to the first frame of data being 
collected but after sample injection (clicked OK 
to continue), the plate status changes to 
processed even though the run is actually 
continuing. 
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Notes

7

Viewing Data During a Run

Run Scheduler >
Plate View

In the tree pane of the Data Collection software, click 
GA Instruments > ga3130xl or ga3130 > instrument name > Run 

Scheduler > Plate View.

Note: The Run Scheduler and Plate View windows display the same 
information.
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Notes

Run Scheduler >
Run View

In the tree pane of the Data Collection software, click 
GA Instruments > ga3130xl or ga3130 > instrument name > Run 

Scheduler > Run View to monitor the status of the scheduled runs.

Note: For default load maps, see Appendix A, “Plate Mapping.”
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Notes

7

Instrument Status In the tree pane of the Data Collection software, click 
GA Instruments > ga3130xl or ga3130 > instrument name > Instrument 

Status to monitor the status of the instrument or the current run.

System Status must be 
‘Ready’ before a run starts

Array and polymer informationOpen the Event Log to monitor 
system messages

System Status changes from green to flashing 
red when errors occur, see Event Log.
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Notes

Instrument Condition Sensor States Pane

The color of the indicator provides a quick way to check the status of the item to the left. 
See the table below for a definition of each color.

Events Box

The Events box lists the:

• Instrument’s recent actions

• Status of each capillary as passed or failed at the end of a spectral calibration 

• Calibration data at the end of a spatial calibration

Some of the events listed in the Events box provide information for service engineers.

Errors Box

The Errors box lists errors that have occurred during the current run. 

Some of the error messages provide information for service engineers. A “fatal” error 
usually requires that you restart the data collection software.

For... A green box 
indicates...

A red box
indicates...

A yellow box 
indicates...

Laser Laser is off Laser is on Laser is idle

EP Electrophoresis is off Electrophoresis is on —

Oven Oven is off Oven is on —

Front Doors Doors are closed Doors are open —

Oven Door Door is closed Door is open —

Autosampler Autosampler is homed Autosampler is forward —
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Notes

7

Instrument Status
> EPT Chart

In the tree pane of the Data Collection software, click GA Instruments > 
ga3130xl or ga3130 > instrument name > Instrument Status >  EPT 

Chart. The EPT chart displays real-time electrophoresis (EP) data during a run.
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Notes

Instrument Status
> Event Log

In the tree pane of the Data Collection software, click GA Instruments > 
ga3130xl or ga3130 > instrument name > Instrument Status >  Event 

Log. The Event log itemizes events such as errors and general information for all data 
collection steps.

Clear error messages by clicking Clear Errors. The System Status light flashes red until 
all errors are cleared. Take corrective action based on error message.

Note: This view can also be used to monitor spectral calibration results in real time to 
verify the capillary-by-capillary processing status.

Clear Errors changes the System status from red to green (ready state).
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Notes

7

Capillaries Viewer In the tree pane of the Data Collection software, click GA Instruments > ga3130 
or ga3130xl >  instrument name > Capillaries Viewer. Use the Capillary Viewer 
to examine the quality of the raw data during a run for several capillaries at once.

Check Boxes

Select the check boxes of the capillaries to view their electropherograms. The capillaries 
are displayed in the order in which the boxes are checked. The more boxes that are 
selected, the slower the refresh window rate.

Raw Data An electropherogram is a graph of relative dye concentration against time, plotted for 
each dye. The displayed raw data has been corrected for spectral overlap 
(multicomponented). 

How to Zoom

To zoom in and out:

1. Select a rectangular area over the area of interest by holding down the mouse 
button. Release the mouse button to zoom in.

2. Click  to return to full view.

Select check boxes 
of capillaries to 
display

Raw, 
multicomponented 
data

Click individual colors to view or hide them
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Notes

Cap/Array Viewer In the tree pane of the Data Collection software, click GA Instruments > ga3130 
or ga3130xl >  instrument name > Cap/Array Viewer. Use the window during a 
run to examine the quality of your data, which is displayed as color data for the entire 
capillary array. You can view all the capillaries (vertical axis) as a function of time/scan 
numbers (horizontal axis).

How to Zoom

To zoom in and out:

1. Select a rectangular area over the area of interest by holding down the mouse 
button. Release the mouse button to zoom in.

2. Click  to return to full view.

Click individual colors to view or hide them

Electrophero-
gram 
displays 

Raw data 
display for 
selected 
capillary (4) 

Capillary
order

0 End

4

1
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Notes

7

Working with Data in The Run History View

Run History Components

Elements of the
Run History Utility

Use the Run History utility only with completed runs stored in the local 3130/3130xl 
genetic analyzer Data Collection database. It does not provide real-time viewing of 
collecting runs.

In the left tree pane, click the icon next to the function to launch it.

Elements Within the Run History Utility

Note: If Cleanup Database has been used, you cannot view processed data in Run History. 

Icon Element Displays the...

EPT Viewer Electrophoresis data of the run, such as voltage, current, 
and oven temperature profiles.

Event Log Event messages associated with the run.

Instrument 
Protocol

Instrument protocol and run module settings used for the 
run.

Spatial 
Calibration 
Viewer

Spatial calibration associated with the run.

Capillaries 
Viewer

Individual electropherogram for each sample in the run.

Cap/Array 
Viewer

Array view of the run.

Spectral 
Viewer

Spectral calibration used for the run.

Reextraction Extraction and analysis status for all samples in the run. 
See “Viewing Autoextraction Results” on page 147 for 
more details.
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Notes

Viewing Data from a Completed Run in the Data Collection 
Software
View data using two formats within the 3130/3130xl 
genetic analyzer Data Collection software under the 
Run History icon: 

• In the Cap/Array Viewer window (in much the 
same way that you might view the gel file output 
from an ABI PRISM® slab gel instrument).

• In the Capillary Viewer window, capillary-by-
capillary.

Viewing Data from a Completed Run

1. In the tree pane of the Data Collection software, 
click GA Instruments > ga3130xl or 
ga3130 > Run History to select the run you 
want to view.

2. Search for your run by either Barcode or 
Advanced search. 

3. After choosing the run, click the run history 
elements, such as Cap/Array Viewer or the 
Capillary Viewer from the left tree pane to look 
at the run data.
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Notes

7

Viewing Autoextraction Results

Overview After a run is completed, extraction and analysis is performed automatically, using the 
settings in the Plate Editor and the Results Group. View the results of extraction and 
analysis in the Reextraction Panel. Reextract samples with the same settings, or with 
different Analysis Protocols or Results Groups. This process can be useful for 
many reasons:

• The destination location may not have been available during extraction.

• Some samples may have failed analysis and a different Analysis Protocol might be 
more successful.

• Samples might be saved in different locations, or with no analysis at all to 
save space.

• Sample names may need to be edited.

Sample File
Destinations

Locate the Results Group’s Naming Tab and check the Destination Tab and Run Folder 
Name Format to find the sample file destination.

Effects of
Changes Made in
the Reextraction

Panel

Changes made in the Reextraction Panel to a Results Group, Analysis protocol, sample 
names, or Comments, also change in the original plate record. The original plate 
information is overwritten.
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Notes

Selecting and Queuing Samples for 
Extraction

Queue individual samples for reextraction to 
experiment with different Analysis Protocols for 
samples that have failed initial extraction.

1. Click  (Run History).

2. Enter the plate name for a plate that has been 
completed, or click Search. Plates that have runs 
still pending cannot be reextracted. All the runs 
from that plate appear in the window. 

3. Select a run from the list. 

4. Click  (Reextraction) in the left tree pane to 
display the Reextraction window.

5. Click the check boxes in the Extract column to 
select the samples to be reextracted.

6. Click Extract to start the reextraction. 

Note: Reextracted sample files are saved in the 
original folder that data was extracted to unless 
this destination was changed through the Results 
Group.
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Notes

7

Elements of the Reextraction Window

All the samples are displayed with the results of 
extraction and analysis.

Note: Sort the columns of the re-extraction panel by 
holding the shift key and then clicking on a column 
header.

Reextraction Window for Sequencing Analysis

Use check boxes to 
select samples to 
be reextracted Select a run Results of extraction and analysis

Click here to start extraction

Use these buttons if several samples 
are highlighted
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Notes

Reextraction Window for Fragment Analysis

Use check boxes to select 
samples to be reextracted Select a run Results of extraction 

Click here to start extraction

Use these buttons if several 
samples are highlighted
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Notes

7

Results Column The results of extraction and analysis are color coded in the Results column. The 
following table lists the colors and their values for Sequencing Analysis.

The Results column, by default, shows only the beginning of any processing message. 
The entire message and the sample file location can be viewed by expanding the cell. 
There is a tooltip view for each sample results message.

Color Value

Red Extraction or analysis failed

Note: Descriptive messages can be viewed by resizing the Results column to 
view all text.

Yellow Warnings for extraction or analysis

Note: Descriptive messages can be viewed by resizing the Results column to 
view all text.

Green Successful extraction (with no analysis intended), or successful extraction 
and analysis.

Tooltip view. Access by placing the cursor over the sample of interest

Drag the cell’s edge to expand the column
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Notes

Expanded column

Quality Column The Quality column represents the quality values for an entire sequence. Quality Values 
are only assigned to analyzed samples when using the KB™ Basecaller. 

Colors displayed and their associated value range

The column is empty (white) if:

• Analysis was not performed

• Analysis failed

• ABI Basecaller was used for analysis. This basecaller does not assign 
Quality Values.

Color Quality Value Range

Red < 15

Orange ≥ 15 and < 20

Yellow ≥ 20 and < 30

Green > 30

Note: For more information on KB Basecaller and Quality Values, see the Applied 
Biosystems DNA Sequencing Analysis Software v5.1 User Guide, PN 4346366.



D
R

A
FT

N
ov

em
b

er
 1

6,
 2

00
4 

12
:3

7 
p

m
, 0

7_
R

un
In

st
ru

m
en

t.
fm

Chapter 7 Running the Instrument
Viewing Autoextraction Results

Applied Biosystems 3130/3130xl Genetic Analyzers Getting Started Guide 153

Notes

7

Results Group and Analysis Protocol 
Columns

You can edit and make changes for reextraction to the 
Results Group and the Analysis Protocol (Analysis 
Method in the GeneMapper® software).

Note: Select an entire column in the Reextraction 
window by clicking on the column header. For 
example, clicking on the Extract column header 
selects all samples. Clicking the Uncheck or Check 
buttons at the bottom of the window, enables or 
disables the check boxes for each sample. The fill-
down command (Ctrl+D) works the same here as in 
the Plate Editor for easier information input.

Sorting the Samples 

1. Hold down the shift key while clicking on the 
column header to sort samples according to the 
column properties. 

2. Shift-click again to sort them in reverse order. 
Sort by:

• Capillary number

• Well position 

• Results

• Quality 

• Extract column

Note: For example, bring all of the failed 
analysis or extraction samples to the top of the 
column. Now they can be viewed without having 
to scroll down to each sample individually.
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Notes

Reextracting Selected Samples

1. Expand the Results column cells for any yellow 
or red results to see a description of the warning 
or failure.

2. If desired, select a new Results Group, or edit the 
current one. Selecting a new Results Group 
allows you to turn off autoanalysis, change the 
samples and folder naming options, the location 
where they are placed, and the owner of the 
Results Group. 

3. If desired, change the Analysis Protocol to 
experiment with different ways of analyzing the 
sample, using a different basecaller for example.

4. Check the check box in the Extract column for 
the samples you wish to extract again.

5. Click Extract.

Note: Reextraction creates an entirely new 
sample file and does not replace the previously 
saved sample file. The presence of a previous 
sample file has no effect on the creation of a new 
sample file. If the same naming options that are 
used for reextraction are identical to those used 
previously, a number is appended to the 
filename. For example, if the first sample is, 
“sample 01.ab1” then the second sample would 
be, “sample 01 (1).ab1.”
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Notes

7

Using Autoanalysis Manager Software
Use Autoanalysis Manager software with SeqScape and/or GeneMapper software. The 
Autoanalysis Manager software is installed by the SeqScape or GeneMapper software 
installation CD. 

Autoanalysis occurs in the following sequence:

1. When data collection software finishes a run, the Message Service sends the 
message “Run Completed.”

2. The Autoanalysis Manager receives the message, and the job is submitted. The job 
appears in the General tab. 

3. The Autoanalysis Manager polls for jobs every 2 minutes and opens the automated 
processing version of SeqScape and/or GeneMapper software to analyze the data. 

4. At the end of analysis, the status in the Autoanalysis Manager is updated.

Files Created The data collection software stores the sample files in the location specified in the results 
group. The Autoanalysis Manager copies the files into the Data Store for SeqScape or 
GeneMapper processing.

To maintain sufficient storage space on your hard drive, delete or transfer unnecessary 
sample files to a different network or CD.

Autoanalyzed
Samples

Note: If your GeneMapper or SeqScape software was opened during autoanalysis, then 
close your analysis application and relaunch the Autoanalysis Manager.

Once an internal message from the instrument is received by the Autoanalysis Manager, 
it opens the automated processing version of SeqScape and/or GeneMapper software to 
autoanalyze the samples. The standard user version of SeqScape and/or GeneMapper 
software must be closed in order for autoanalysis to begin. 
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Notes

Components

The Autoanalysis Manager has two or three tabs:

• General tab

• GeneMapper tab, if GeneMapper v3.7 or GeneMapper ID v3.2 software is installed

• SeqScape tab, if SeqScape software is installed

General Tab The General tab shows the jobs that have been submitted and their status.

Command Buttons in the General Tab

Command Button Functions in the General Tab

Button Name Function

Delete Job Deletes an individual job/project from the Autoanalysis Manager 
list. 

Does not delete sample files, SeqScape or GeneMapper 
software project.

Delete Completed Jobs Deletes all completed jobs/projects from the Autoanalysis 
Manager list. Only successful jobs are deleted. 

Does not delete sample files, SeqScape or GeneMapper 
software projects.

Move Job Up The active job/project is always given a queue number of 1. Once 
job 1 is finished analyzing, job 2 becomes job 1 and all other 
numbers are changed accordingly. Use the Move Up/Down 
buttons if you want to rearrange the analysis order. 

Move Job Down
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Notes

7

GeneMapper
Software Tab

The GeneMapper software tab shows the jobs that have been submitted and their status.

Command Buttons in the GeneMapper Software Tab

Command Button Functions in the GeneMapper Software Tab

Button Name Function

Configure Schedule • Next Analysis Time:

Enables you to set a start time for autoanalysis. Before this 
time arrives, autoanalysis of projects will not occur. 

• Periods restricting automated analysis:

Enables you to set times during which autoanalysis will not 
occur. Useful if you know that you are going to be reviewing 
data during a certain time period and don’t want to be 
bothered by the “Runs ready for processing” dialog box. Runs 
build up in the queue until the restricting time period is over at 
which time the runs will be autoanalyzed. 

• Automatic Deletion of Completed Jobs:

Enables you to set the software to automatically delete 
successfully completed jobs. Jobs that failed or have not been 
analyzed will not be deleted. Only the Autoanalysis Manager 
job is deleted, sample files and GeneMapper software projects 
are not.

Edit Properties Enables you to change the following settings:

• Job/Project Name

• UserName: GeneMapper software UserName

• Password: Matching password for GeneMapper software 
UserName

• Queue position: Enter a new queue position number for the 
project 
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Notes

Requeue Job • Samples that need to be autoanalyzed have queue numbers 
listed in the # column.

• Samples that are already analyzed or failed, have a blank cell 
in the # column. 

To resubmit a job for autoanalysis, use the Requeue Job 
button to assign a queue number to that job.

Delete Job • Deletes an individual job/project from the AutoAnalysis 
Manager list. 

Does not delete sample files or GeneMapper software project.

Delete Completed Jobs • Deletes all completed jobs/projects from the AutoAnalysis 
Manager list. Only successful jobs are deleted. 

Does not delete sample files or GeneMapper software 
projects.

Button Name Function
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Notes

7

SeqScape
Software Tab

The SeqScape software tab shows the jobs, project, and status information.

Command Button Functions in the SeqScape Software Tab

Button Name Function

Details Displays the project in the navigation pane 

Resubmit Submits a job for analysis

Edit Properties Edits the name and password (active only if analysis failed)

Delete Deletes a job from the Autoanalysis Manager
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Notes

Viewing Analyzed Data

Locating Sample
Files

Analyzed sample files are extracted into a run folder defined in the Naming tab of your 
Results Group, and placed in a location defined in the Destination tab.

The default location is: 

E:\AppliedBiosystems\UDC\Data Collection\Data\ <instrument type>\<instrument 
name>\<Run Name>

Locating Sample Files

Locate the reextracted data in the location defined by the Results Group or the default 
destination location.

Viewing Sample
Files

Use the Sequencing Analysis, SeqScape, or the GeneMapper Software to view re-
extracted sample electropherogram data, both raw, and analyzed. 

Sample file type File extension

Sequencing, SeqScape .ab1

Fragment analysis .fsa
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Notes

Plate Mapping

Injection Scheduling
Samples are scheduled for injection based on their position in a 96-or 384-well plate and 
the capillary number. Study the appropriate plate mapping patterns described in “96-
Well Plate Mapping” or “384-Well Plate Mapping” to arrange your samples according to 
your preferred injection priority.

The injection schedule system is based on the:

• Order of the linked plates (3130xl instrument only). See page 128 for linking plate 
information.

• Sample priority value in the plate record.

If all priorities are set to 100 (default), then runs are scheduled as outlined below. See the 
Applied Biosystems 3130/3130xl Genetic Analyzers Maintenance, Troubleshooting, and 
Reference Guide on “Run Priority Scheduling”.

Capillary Array Map
The capillary numbers in the capillary array are shown in the layout below. The capillary 
array layout is the same for both 96- and 384-well plates.

Capillary Number Layout
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Notes

96-Well Plate Mapping

3130xl Genetic
Analyzer

For a 96-well plate, injections are made from every well in two consecutive rows, 
starting with an odd row. A full 96-well plate requires six runs to inject all samples. See 
the examples below where samples (grey) and capillary number (number) positions can 
affect your number of runs.

3130 Genetic
Analyzer

For a 96-well plate, injections are made from four consecutive wells in a row. A full plate 
of 96 sample requires 24 runs to inject all samples once.

In the following example of a 96-well plate, the gray circles represent samples and the 
number in the well indicates capillary number. It takes four runs to inject 16 samples. 

Efficient Sample Placement Inefficient Sample Placement

Inject 48 samples using three runs Inject 32 samples using four runs
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1

13579111315

246810121416

13579111315

246810121416
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246810121416
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Run 3
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246810121416
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3

Run 4 Run 3
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Notes

384-Well Plate Mapping

3130xl Genetic
Analyzer

For a 384-well plate, injections are made from every other well and every other row. A 
full plate of 384 samples requires 24 runs to inject all samples once.

The example below is the injection pattern for the first four injections, starting with well 
A01. The light gray circles represent samples and the dark gray circles indicate the 
injection pattern.

3130 Genetic
Analyzer

For a 384-well plate, injections are made from every other well. A full plate of 384 
sample requires 96 runs to inject all samples once.

The example below is the injection pattern for the first six injections, starting with well 
A01. The light gray circles represent samples and the dark gray circles indicate the 
injection pattern.
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Index

Numerics
3130 basecaller and DyeSet/Primer files 66, 67

A
ABI PRISM® BigDye® Primer Cycle Sequencing Kits

table, dye sets and standards 29
ABI PRISM® dGTP BigDye® Terminator Cycle 

Sequencing Ready Reaction Kit, table of dye 
set and standards 29

ABI PRISM® dGTP BigDye® Terminator v 3.0 Cycle 
Sequencing Ready Reaction Kit

table of dye set and standards 29
ABI PRISM® dRhodamine Terminator Cycle Sequencing 

Kit
table of information 29

Activating spectral calibration 47

AmpFlSTR kits
matrix standard 30
table of dye sets, filter, modules 5

analysis protocol
deleting 68, 97
editing 68, 96
export 69, 97
general description 55
import 69, 97
options 58
options, SeqScape software 87

analysis, manual 54, 83, 106

analyzing GeneMapper Software data 160

anode buffer reservoir
filling 19
function 11

Applied Biosystems
contacting xi
customer feedback on documentation x
Information Development department x
Technical Support xi

array length, polymer type, table 36

array port, illustration of 12

assembling the plate 34

assumptions for using this guide ix

Australian EMC standards xxiii

autoanalysis

GeneMapper Software, computer name 107
manually, fragment analysis documentation 106
manually, Seqscape software documentation 83
manually, sequencing documentation 54
sequencing 54

Autoanalysis Manager
components 155
explained 82
general tab 156
starting 131
using 155

autoextraction
overview 147

Automated Processing tab 118

automated SeqScape analysis 82

automatic analysis, before you start 83

autosampler 18
function 11

B
barcode reader 6

barcode, type of search 40

basecaller and DyeSet/Primer files 66

basecaller files 66, 67

BigDye® Terminator chemistry, information tables 66

BigDye® Terminator v3.1 Cycle Sequencing Kit
table, dye set and standard 29

biohazardous waste, handling xx

bold text, when to use ix

buffer
hazards 32
making 16

buffer fill-line 12

buffer reservoir, anode, illustration of 12

buffer valve pin, illustration of 12

C
calibration standards

types, fragment analysis 30
types, sequencing 29

Canadian safety standards xxiii

cap/array viewer 144

capillaries viewer 143
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capillary array
function 11
illustration of 12
installing or replacing 13

capillary array knob and tip, illustration of 12

capillary array length
polymer type, table 36

cathode buffer reservoir, filling 17

CAUTION
description xiv
example xv

Change Polymer Type Wizard, using 15

characters
acceptable 54, 83, 106

check valve
diagram of 12

chemical safety xviii

chemical safety guidelines xix

chemical waste
hazards xx
safety xx
safety guidelines xx

chemical waste disposal, guidelines xx

computer
assigning a unique name 9
starting 7

condition number, spectral calibration 42

conventions
bold text ix
IMPORTANTS! ix
in this guide ix
italic text ix
menu commands ix
Notes ix
user attention words ix

conventions, safety xiv

creating
analysis protocol for autoanalysis 62, 93
GeneMapper Software plate record for 

autoanalysis 123
SeqScape Software plate record 101
Sequencing Analysis plate record for 

autoanalysis 77
customer feedback, on Applied Biosystems 

documents x

D
DANGER

description xiv
example xv

data
how to zoom 143
viewing 137

viewing analyzed sequencing data 160
viewing complete run 146

Data Collection software
starting 9

data collection software, starting 9

destinations 147

detection cell block and heater
function 11

documentation
GeneMapper Software User Guide (PN) 106
related x

double-tapered ferrule, illustration of 12

dye primer chemistry, information table 67

dye set
fragment analysis 30, 114
table, sequencing 29

Dye Terminator chemistry, files 66

DyeSet/Primer files 66, 67
list of 64, 94

E
E dye set, sequencing kit table 61

electrical hazard symbol xvi

electrical safety xxi

electrical shock hazards xxi

electrical symbols, on instruments xv

electrode, illustration of 12

electromagnetic compatibility standards. See EMC 
standards

electropherogram, definition 143

EMC standards xxiii
Australian xxiii
Canadian xxiii
European xxiii

EPT chart 141

ergonomic safety xxii

errors box 140

European EMC standards xxiii

European safety standards xxiii

event log 142
icon, displays 145

events, box 140

F
file extension 160

file naming, invalid characters 54

fill down special, function 38

fill line, anode buffer reservoir 19

filter set
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fragment analysis 5
find all plate search 40

fragment analysis
data analysis 160
filter set 5
kit types 5
passing profiles, spectral calibration 51
run modules 113
run, average time 133

function 11

G
GeneMapper Software

computer name 107
elements 109
generic 107
instrument protocol 108
plate records 108
results group 108

GeneMapper Software tab 157

GeneMapper™ Software and GeneMapper™ ID 
Software 106

general hazard symbol xvi

guidelines
chemical safety xix
chemical waste disposal xx
chemical waste safety xx
waste disposal xx

H
hard drive space, automatic checking 132

hazard icons
accompanying safety alert words xiv
components xiv
described xiv
in documents xiv
on instruments xiv, xvi
See also hazard symbols
See also safety symbols

hazard symbols
electrical xvi
general xvi
hot surface xvi
in documents xv
laser hazard xvi
moving parts xvi
on instruments xvi
See also hazard icons
See also safety symbols

hazards
chemical waste xx
electrical shock xxi
laser xxi
moving parts xxi
moving/lifting instrument xvii

physical xxi
repetitive motion xxii

I
illustration of 12

IMPORTANT
description xiv
example xv

IMPORTANTS!, description ix

Information Development department, contacting x

Install Array Wizard
using 13

installation category xxi

instrument
condition, status 140
diagram of interior 11
documentation x
EPT status 141
layout 2
operation 130
setup 12
starting the system 8

instrument operational safety, instructions for xviii

instrument protocol
creating 35
creating for SeqScape software 88
creating, for fragment analysis 109, 112
general description 55
icon, displays 145
options, SeqScape software 87
options,s equencing 58

instrument status 139

interconnect tube 12

invalid characters in names 54, 83, 106

italic text, when to use ix

K
KB basecalling run modules 66

L
labels, instrument safety xvi

laser hazard xxi
symbol xvi
warnings xxii

laser safety xxi
laser classification xxi
requirements xxii

Launching Data Collection software 9

layout, instrument 2

length of read, definition 3

linking a plate 128
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LOR definition 3

lower polymer block 11

lower polymer block, illustration of 12

Luer fitting, illustration of 12

M
manual analysis, fragment analysis documentation 106

manual analysis, Seqscape software documentation 83

manual analysis, sequencing documentation 54

matrix standard
fragment analysis 30

matrix standards
fragment analysis 114
preparing for sequencing 31
sequencing 29

menu commands, conventions for describing ix

mixed plate record 55

modules
fragment analysis 4, 5
KB basecalling 66
sequencing 3
spectral 36

mounting pin, illustration of 12

moving and lifting
computer xviii
monitor xviii

moving and lifting instrument, safety xvii

moving parts
hazard xxi
hazard symbol xvi
safety xxi

MSDSs
description xviii
obtaining xix
referring to xix, xx
when to review xviii

N
Naming

tab, fragment analysis 118
Notes, description ix

O
O-ring, illustration of 12

oven
function 11

overflow hole, illustration of 12

overvoltage category (rating) xxi

overvoltage rating xxi

P
pausing a run 133

PDP motor cover, illustration of 12

physical hazard safety xxi

physical hazards xxi

piston, illustration of 12

plate assembly
diagram 34
placing in instrument 39

plate editor, filling in 37

plate manager, access 37

plate record
creating 37
creating for GeneMapper Software 

autoanalysis 123
creating for SeqScape Software 101
creating for Sequencing Analysis autoanalysis 77
discussed 55, 83, 108
elements, sequencing analysis 56
linking and unlinking 128
mixed 55
search 40

plate view 137

plates
linking and unlinking from plate records 128
sealing 33

polymer
array length, table 36
changing to new type 15
replenishing or changing 14
when to add or change 14

polymer delivery pump
diagram 12

polymer supply bottle cap with hole, illustration of 12

polymer supply bottle, illustration of 12

polymer supply tube illustration of 12

protocol manager, access 35

pump block 12
function 11

pump chamber, illustration of 12

Q
quality column 152

quality value range 152

Q-value, spectral calibration 42

R
radioactive waste, handling xx

reader, barcode 6
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reextraction
editing Results Group, Analysis Protocol, Analysis 

Method 153
results column 151
selected samples 154
selecting 148
window elements 149

reextraction panel
effects of changes made in 147

repetitive motion hazard xxii

Replenish Polymer Wizard
using 15

reservoirs
filling 17
positions on the autosampler 18

resolution
fragment analysis 4

results column, reextraction 151

Results Group
creating for sequencing analysis 70
creating, fragment analysis 115
creating, SeqScape software 98
editor, GeneMapper 107
general description 55
importing and exporting 100
options 57
options, SeqScape software 165

run
fragment analysis 133
requires plate record 55, 84, 108
sensor states 140
sequencing, average time 132
starting 130
starting, stopping, skipping, pausing 133
viewing data 137

run history utility 145

run modules
automated steps, description 132
selecting for fragment analysis 113
selecting spectral 36

run schedule, viewing 129

run scheduler
spatial 22
verifying schedule 129

run time
fragment analysis 4
spectral calibration 41

running buffer, making and storing 16

S
safety

before operating the instrument xvii
chemical xviii
chemical waste xx

conventions xiv
electrical xxi
ergonomic xxii
instrument xvii
instrument operation xviii
laser xxi
moving and lifting instrument xvii
moving parts xxi
physical hazard xxi
standards xxiii
workstation xxii

safety alert words
accompanying hazard icons xiv
CAUTIONS xiv
DANGERS xiv
description xiv
IMPORTANTS xiv
WARNINGS xiv

safety labels, on instruments xvi

safety requirements, laser xxii

safety standards
Canadian xxiii
European xxiii
U.S. xxiii

safety symbols
on instruments xvi
See also hazard symbols

sample file 147
default location 160
type 160

samples
autoanalyzing 155
loading 32

sensor states 140

SeqScape software tab 159

SeqScape Software v2.5
autoanalysis 82
plate editor 84
plate record elements 85
user guide P/N 82

sequencing
automated, creating protocols 59
automation, required files 55
data, automating the analysis 82
matrix standards 31
passing profiles, spectral calibration 49
plate editor 55
run time 132
specifications 3
spectral run modules 36
viewing analyzed data 160

sequencing chemistry
supported kits 28

service console, using 9

set (activate) spectral calibration 47
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software, starting 9

spatial calibration
accepting or rejecting 24
creating 22
evaluating profiles 23
examples of profiles 25
viewer 145
when required 22

specifications
fragment analysis 4
sequencing 3

spectral calibration
creating plate record 37
evaluating results 43
pass/fail status 42
passing profiles, fragment analysis 51
passing profiles, sequencing 49
performing a 37
preparing standards for 31
run times 41
set spectral calibration 47
when to perform 28

spectral calibration standard, types 29

spectral viewer 145

spectral viewer, blank or deactivated 47

standards
EMC xxiii
safety xxiii

starting
run 133
spectral calibration run 40

status
instrument 139
service console 9

status lights
on instrument startup 8

stopping a run 133

supported sequencing chemistry kits 28

symbols
hazard xvi
hot surface xvi

symbols on instruments
electrical xv
safety xvi

T
tables

summary 3
Technical Support, contacting xi

text conventions ix

toolbar 133

training, information on xi

U
unlinking a plate 129

Update Cap Array Info
using 13

US safety standards xxiii

user attention words, described ix

utility, run history 145

V
viewer

cap/array 144
capillaries 143
icons and display information 145
spectral 145

W
WARNING, description xiv

waste disposal, guidelines xx

water seal, illustration of 12

water trap
illustration of 12

wizard
Replenish Polymer Wizard, using 15
Update Cap Array Info, using 13

workstation safety xxii

Z
Z dye set, sequencing kit table 61





Applera is committed to providing the world’s 
leading technology and information for life scientists. 
Applera Corporation consists of the Applied Biosystems 
and Celera Genomics businesses.

Headquarters
850 Lincoln Centre Drive
Foster City, CA 94404 USA
Phone: +1 650.638.5800
Toll Free (In North America): +1 800.345.5224
Fax: +1 650.638.5884

Worldwide Sales and Support
Applied Biosystems vast distribution and service 
network, composed of highly trained support and 
applications personnel, reaches 150 countries on six 
continents. For sales office locations and technical 
support, please call our local office or refer to our Web 
site at www.appliedbiosystems.com.

Printed in the USA, 11/2004
Part Number 4352715 Rev. B


	Front cover
	Copyright page
	Workflow
	Preface
	How to Use This Guide
	How to Obtain More Information
	How to Obtain Support

	Safety
	Safety Conventions Used in This Document
	Symbols on Instruments
	Safety Labels on Instruments
	General Instrument Safety
	Chemical Safety
	Chemical Waste Safety
	Electrical Safety
	Physical Hazard Safety
	Laser Safety
	Workstation Safety
	Safety and Electromagnetic Compatibility (EMC) Standards

	1 Preparing the Instrument
	Instrument Description
	Application Summary Tables
	Barcode Readers
	Starting the 3130/3130xl Genetic Analyzer System
	Data Collection Software
	Preparing the Instrument
	Preparing Buffer and Filling Reservoirs

	2 Performing a Spatial Calibration
	Spatial Calibration
	Creating a Spatial Calibration File
	Evaluating a Spatial Calibration File
	Examples of Spatial Profiles

	3 Performing a Spectral Calibration
	Spectral Calibration
	Preparing the Spectral Calibration Chemistry
	Loading Samples
	Creating a Spectral Instrument Protocol
	Performing a Spectral Calibration
	Evaluating the Spectral Calibration Data
	Activating a Spectral Calibration
	Examples of Passing Sequencing Spectral Calibrations
	Examples of Passing Fragment Analysis Spectral Calibrations

	4 Autoanalysis and Sequencing Analysis Software
	Sequencing Analysis Software
	About Plate Records and Sequencing Analysis
	Creating Protocols for Automated Sequencing Analysis
	Analysis Protocol for Sequencing Analysis
	Results Group for Sequencing Analysis
	Filling Out a Sequencing Analysis Plate Record

	5 Autoanalysis and SeqScape Software
	SeqScape Software
	About Plate Records and Seqscape Software
	Creating Protocols for Automated SeqScape Software Analysis
	Filling Out a SeqScape Software Plate Record

	6 Autoanalysis and Fragment Analysis
	GeneMapper Software
	About GeneMapper Software Plate Records
	Creating Protocols for Automated Fragment Analysis
	Creating a GeneMapper Software Plate Record

	7 Running the Instrument
	Preparing Samples and Plate Assemblies
	Linking and Unlinking a Plate
	Running the Instrument
	Controlling the Run
	Set Up for Continuous Operation
	Working with Data in The Run History View
	Viewing Data from a Completed Run in the Data Collection Software
	Viewing Autoextraction Results
	Using Autoanalysis Manager Software
	Viewing Analyzed Data

	A Plate Mapping
	Injection Scheduling
	Capillary Array Map
	96-Well Plate Mapping
	384-Well Plate Mapping

	Index
	Back page

